Aerosol Instrument Manager® Software
for Condensation Particle Counters, EPC™ Environmental Particle Counter™ Monitor, Water-based Condensation Particle Counters, and Electrical Aerosol Detector

User’s Manual

P/N 1930062, Revision J
October 2010
Start Seeing the Benefits of Registering Today!

Thank you for your TSI instrument purchase. Occasionally, TSI releases information on software updates, product enhancements and new products. By registering your instrument, TSI will be able to send this important information to you.

http://register.tsi.com

As part of the registration process, you will be asked for your comments on TSI products and services. TSI's customer feedback program gives customers like you a way to tell us how we are doing.
# Aerosol Instrument Manager® Software
for Condensation Particle Counters, EPC™ Environmental Particle Counter™ Monitor, Water-based Condensation Particle Counters, and Electrical Aerosol Detector

User's Manual

<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Introduction</td>
<td>1</td>
</tr>
<tr>
<td>Installing the Software</td>
<td>2</td>
</tr>
<tr>
<td>Getting Started</td>
<td>3</td>
</tr>
<tr>
<td>Software Procedures</td>
<td>4</td>
</tr>
<tr>
<td>Setting Up for Auto Recovery</td>
<td>5</td>
</tr>
<tr>
<td>Appendixes</td>
<td></td>
</tr>
</tbody>
</table>
Manual History

The following is a manual history of the Aerosol Instrument Manager® Software for Condensation Particle Counters, EPC™ Environmental Particle Counter™ Monitor, Water-based Condensation Particle Counters, and Electrical Aerosol Detector User’s Manual (Part Number 1930062).

<table>
<thead>
<tr>
<th>Revision</th>
<th>Date</th>
</tr>
</thead>
<tbody>
<tr>
<td>First Version</td>
<td>May 2002</td>
</tr>
<tr>
<td>A</td>
<td>October 2002</td>
</tr>
<tr>
<td>B</td>
<td>May 2004</td>
</tr>
<tr>
<td>C</td>
<td>August 2004</td>
</tr>
<tr>
<td>D</td>
<td>January 2005</td>
</tr>
<tr>
<td>E</td>
<td>November 2005</td>
</tr>
<tr>
<td>F</td>
<td>March 2006</td>
</tr>
<tr>
<td>G</td>
<td>April 2006</td>
</tr>
<tr>
<td>H</td>
<td>April 2010</td>
</tr>
<tr>
<td>J</td>
<td>October 2010</td>
</tr>
</tbody>
</table>
Warranty

Part Number: 1930062 / Revision J / October 2010
Copyright: ©TSI Incorporated / 2002–2010 / All rights reserved.
Address: TSI Incorporated / 500 Cardigan Road / Shoreview, MN 55126 / USA
Email Address: particle@tsi.com
World Wide Web Site: http://www.tsi.com/
Telephone No.: 1-800-874-2811 (USA only) or (651) 490-2811
Fax No.: (651) 490-3824

Limitation of Warranty and Liability (effective July 2000)

Seller warrants the goods sold hereunder, under normal use and service as described in the operator’s manual, shall be free from defects in workmanship and material for (12) months, or the length of time specified in the operator’s manual, from the date of shipment to the customer. This warranty period is inclusive of any statutory warranty. This limited warranty is subject to the following exclusions:

a. Hot-wire or hot-film sensors used with research anemometers, and certain other components when indicated in specifications, are warranted for 90 days from the date of shipment.

b. Parts repaired or replaced as a result of repair services are warranted to be free from defects in workmanship and material, under normal use, for 90 days from the date of shipment.

c. Seller does not provide any warranty on finished goods manufactured by others or on any fuses, batteries or other consumable materials. Only the original manufacturer’s warranty applies.

d. Unless specifically authorized in a separate writing by Seller, Seller makes no warranty with respect to, and shall have no liability in connection with, goods which are incorporated into other products or equipment, or which are modified by any person other than Seller.

The foregoing is IN LIEU OF all other warranties and is subject to the LIMITATIONS stated herein. NO OTHER EXPRESS OR IMPLIED WARRANTY OF FITNESS FOR PARTICULAR PURPOSE OR MERCHANTABILITY IS MADE.

TO THE EXTENT PERMITTED BY LAW, THE EXCLUSIVE REMEDY OF THE USER OR BUYER, AND THE LIMIT OF SELLER’S LIABILITY FOR ANY AND ALL LOSSES, INJURIES, OR DAMAGES CONCERNING THE GOODS (INCLUDING CLAIMS BASED ON CONTRACT, NEGLIGENCE, TORT, STRICT LIABILITY OR OTHERWISE) SHALL BE THE RETURN OF GOODS TO SELLER AND THE REFUND OF THE PURCHASE PRICE, OR, AT THE OPTION OF SELLER, THE REPAIR OR REPLACEMENT OF THE GOODS. IN NO EVENT SHALL SELLER BE LIABLE FOR ANY SPECIAL, CONSEQUENTIAL OR INCIDENTAL DAMAGES. SELLER SHALL NOT BE RESPONSIBLE FOR INSTALLATION, DISMANTLING OR REINSTALLATION COSTS OR CHARGES. No Action, regardless of form, may be brought against Seller more than 12 months after a cause of action has accrued. The goods returned under warranty to Seller’s factory shall be at Buyer’s risk of loss, and will be returned, if at all, at Seller’s risk of loss.

Service Policy

Knowing that inoperative or defective instruments are as detrimental to TSI as they are to our customers, our service policy is designed to give prompt attention to any problems. If any malfunction is discovered, please contact your nearest sales office or representative, or call TSI at 1-800-874-2811 (USA) or (651) 490-2811.
Software License  
(effective March 1999)

This is a legal agreement between you, the end user, and TSI Incorporated. By installing the software, you are agreeing to be bound by the terms of this agreement. If you do not agree to the terms of this agreement, promptly return the unopened package and the accompanying items (including written materials and binders or other containers) to TSI for a full refund.

1. GRANT OF LICENSE. TSI grants to you the right to use one copy of the enclosed TSI software program (the “SOFTWARE”), on a single computer. You may not network the SOFTWARE or otherwise use it on more than one computer or computer terminal at the same time.

2. COPYRIGHT. The SOFTWARE is owned by TSI and is protected by United States copyright laws and international treaty provisions. Therefore, you must treat the SOFTWARE like any other copyrighted material (e.g., a book or musical recording) except that you may either (a) make one copy of the SOFTWARE solely for backup or archival purposes, or (b) transfer the SOFTWARE to a single hard disk provided you keep the original solely for backup or archival purposes.

3. OTHER RESTRICTIONS. You may not rent or lease the SOFTWARE, but you may transfer the SOFTWARE and accompanying written material on a permanent basis, provided you retain no copies and the recipient agrees to the terms of this Agreement. You may not reverse-engineer, decompile, or disassemble the SOFTWARE.

4. DUAL MEDIA SOFTWARE. If the SOFTWARE package contains multiple types of media, then you may use only the media appropriate for your single-user computer. You may not use the other media on another computer or loan, rent, lease, or transfer them to another user except as part of the permanent transfer (as provided above) of all SOFTWARE and written material.

5. U.S. GOVERNMENT RESTRICTED RIGHTS. The SOFTWARE and documentation are provided with RESTRICTED RIGHTS. Use, duplication, or disclosure by the Government is subject to the restrictions set forth in the “Rights in Technical Data and Computer Software” Clause at 252.227-7013 and the “Commercial Computer Software - Restricted Rights” clause at 52.227-19.

6. LIMITED WARRANTY. TSI warrants that the SOFTWARE will perform substantially in accordance with the accompanying written materials for a period of ninety (90) days from the date of receipt.

7. CUSTOMER REMEDIES. TSI’s entire liability and your exclusive remedy shall be, at TSI’s option, either (a) return of the price paid or (b) repair or replacement of the SOFTWARE that does not meet this Limited Warranty and which is returned to TSI with proof of payment. This Limited Warranty is void if failure of the SOFTWARE has resulted from accident, abuse, or misapplication. Any replacement SOFTWARE will be warranted for the remainder of the original warranty period or thirty (30) days, whichever is longer.

8. NO OTHER WARRANTIES. TSI disclaims all other warranties, either express or implied, including, but not limited to implied warranties of merchantability and fitness for a particular purpose, with regard to the SOFTWARE and the accompanying written materials.

9. NO LIABILITY FOR CONSEQUENTIAL DAMAGES. In no event shall TSI be liable for any damages whatsoever (including, without limitation, special, incidental, consequential or indirect damages for personal injury, loss of business profits, business interruption, loss of information or any other pecuniary loss) arising out of the use of, or inability to use, this SOFTWARE.

Trademarks

TSI and Aerosol Instrument Manager are registered trademarks of TSI Incorporated.
TSI logo, Scanning Mobility Particle Sizer, SMPS, Environmental Particle Counter, and EPC are trademarks of TSI Incorporated.
Microsoft and Windows are registered trademarks of Microsoft Corporation.
Pentium is a registered trademark of Intel Corporation.
## Contents

- Manual History ......................................................................................... iv
- Warranty .................................................................................................... v
  - Software License (effective March 1999) ........................................... vi
- About This Manual .................................................................................. xi
  - Purpose ................................................................................................ xi
  - Organization ......................................................................................... xi
  - Related Product Literature ................................................................. xii
  - Getting Help ......................................................................................... xiii
  - Submitting Comments ......................................................................... xiii

### CHAPTER 1 Introduction ................................................................. 1-1
  - Particle Concentration and Diameter Concentration ........................ 1-1
  - Notations/Conventions Used in This Manual .................................... 1-3

### CHAPTER 2 Installing the Software .................................................... 2-1
  - Installation Requirements ................................................................. 2-1
  - Installation ......................................................................................... 2-2

### CHAPTER 3 Getting Started ................................................................. 3-1
  - Start the Program .............................................................................. 3-1
  - Open an Existing File ........................................................................ 3-2
  - Change How Data is Viewed ............................................................ 3-3
  - View Another Sample in the Same File ............................................ 3-4
  - Playback (Review) Data Samples .................................................... 3-4
  - Select a Data Hot Spot ..................................................................... 3-6
  - Delete/Undelete Samples ................................................................. 3-6
  - Zoom In and Out on Data in a Graph ............................................... 3-7
  - Print Information Displayed on the Desktop ..................................... 3-8
  - Export Data to a File ......................................................................... 3-9
    - To Export Data to a File Manually ................................................. 3-9
    - To Export Data to a File Automatically ........................................ 3-10
  - Arrange Open Windows .................................................................. 3-10
  - Quit the Program ............................................................................. 3-11

### CHAPTER 4 Software Procedures ....................................................... 4-1
  - How to Set Up Instrument Properties ............................................. 4-1
    - Scheduling Tab ............................................................................. 4-2
    - Settings Tab ................................................................................... 4-5
    - Log Mode 1 Tab (CPC 3007 only) ................................................. 4-5
    - Log Modes 2 and 3 Tab (CPC 3007 only) ..................................... 4-6
    - Instrument Clock Tab (CPC 3007 only) ....................................... 4-8
    - Communications Tab ................................................................. 4-9
3-4 Print Preview
3-5 Export Data Options Box for the Series 3770 CPCs
3-6 Two-Pane Layout of a CPC File
4-1 Scheduling Tab of the Properties Dialog Box
4-2 Scheduling Tab for EPC™ Monitor Model 3783, WCPC Models 3787 and 3788
4-3 The Settings Tab of the Properties Dialog Box
4-4 Log Mode 1 Tab of the Properties Dialog for a CPC 3007
4-5 Log Modes 2 and 3 Tab of the Properties Dialog for a CPC 3007
4-6 Instrument Clock Tab of the CPC 3007 Properties Dialog
4-7 The Communications Tab of the Properties Dialog Box for EAD and CPCs except Series 3770 CPCs, EPC™ Monitor Model 3783, and WCPC Models 3787 and 3788.
4-8 The Communications Tab for Series 3770 CPCs, EPC™ Monitor Model 3783, and WCPC Models 3787 and 3788.
4-9 Import Series 3770 CPC Data Files Dialog Box
4-10 Input Aerosol Instrument Manager® File Name
4-11 3781 WCPC Import/Logging Dialog Box
4-12 3781 WCPC Data Logging Dialog Box
4-13 Clear Memory will Erase ALL of the Logged Data in the 3781 WCPC
4-14 3781 WCPC Currently Logging, Collecting Data Dialog Box
4-15 File Menu Options for EAD and all CPCs and WCPCs
4-16 Run Menu for (A) EAD and All CPCs except CPC 3007; (B) Model 3007 CPC
4-17 Playback Menu
4-18 Format Menu (A) When A Graph Window Is Active; (B) When A Samples List Window Is Active
4-19 The Y-Axis Dialog Box
4-20 (A) The Graph Color Dialog Box; (B) The Table Color Dialog Box
4-21 Font Dialog Box
4-22 View Menu
4-23 Sample Menu
4-24 Window Menu
4-25 Help Menu
4-26 Series 3770 CPC, Model 3783 EPC™ Monitor, and Models 3787/3788 WCPCs Context-Sensitive Menus for Graph Window
4-27 Display Count per Averaging Interval versus Time
4-28 Analog Signal and Concentration in a Single Chart
4-29 Two Chart Display with Analog 1
4-30 Enter Labels for Analog Channels
4-31 Series 3770 CPC Context-Sensitive Menus for Table Window
5-1  Startup and Recovery Dialog Box ............................................................ 5-3
5-2  Tweak UI .................................................................................................. 5-4
5-3  User Accounts Dialog Box ....................................................................... 5-5
C-1  File Question? Dialog Box ...................................................................... 8-2

Tables

4-1  Descriptions of Scheduling Parameters for a CPC, WCPC, EPC™ monitor, or an EAD ................................................................. 4-2
4-2  Descriptions of Scheduling Parameters for EPC™ Monitor Model 3783, WCPC Models 3787 and 3788 ................................. 4-4
4-3  Descriptions for the CPC 3007 Log Mode 1 Tab .................................. 4-6
4-4  Descriptions for the CPC 3007 Log Modes 2 and 3 Tab ...................... 4-7
4-5  Descriptions of the CPC 3007 Instrument Clock Tab ......................... 4-9
4-6  Descriptions for the Communications Tab ........................................... 4-11
D-1  Error Messages for CPCs, EPC™ Monitor, WCPCs, and EAD .......... D-1
About This Manual

Purpose

This is a user’s manual for the Aerosol Instrument Manager® Software as it applies to Condensation Particle Counters (CPCs), EPC™ Environmental Particle Counter™ Monitor (EPC™ monitor), Water-based Condensation Particle Counter (WCPCs), and the Electrical Aerosol Detector (EAD).

Organization

The following is a guide to the organization of this manual:

- **Chapter 1: Introduction**
  This chapter gives an introduction to the Aerosol Instrument Manager® software.

- **Chapter 2: Installing the Software**
  This chapter describes the installation requirements for the software and the installation procedures.

- **Chapter 3: Getting Started**
  This chapter provides getting started information to help you understand the basics of how the software works.

- **Chapter 4: Software Procedures**
  This chapter describes how to set properties for a Condensation Particle Counter, Environmental Particle Counter™ Monitor, or an Electrical Aerosol Detector and how to collect sample data for analysis by the program. It also provides a description of all menus and menu items.

- **Chapter 5: Setting up for Auto Recovery**
  This chapter describes how to setup and restart data collection after a power failure and how the software resumes data collection tasks interrupted by the power failure.

- **Appendix A: Data Files, Project Files, and Stored Parameters**
  This appendix describes the two types of data storage files: data files and project files. It also describes the parameters stored in them and in the aim.ini file.

- **Appendix B: Accelerator Keys**
  This appendix lists all the accelerator keys and their functions.
Appendix C: Sequence Files
This appendix describes sequence files that are generated for sample sessions that run past midnight.

Appendix D: Error Messages
This appendix lists the messages you may encounter when using the software and suggests the actions you should take.

Related Product Literature

- **Model 3007 Condensation Particle Counter Operation and Service Manual** (part number 1930035) TSI Incorporated
- **Model 3772/3771 Condensation Particle Counter Operation and Service Manual** (part number 1980529) TSI Incorporated
- **Model 3775 Condensation Particle Counter Operation and Service Manual** (part number 1980527) TSI Incorporated
- **Model 3776 Ultrafine Condensation Particle Counter Operation and Service Manual** (part number 1980522) TSI Incorporated
- **Model 3781 Water-based Condensation Particle Counter Operation and Service Manual** (part number 1930111) TSI Incorporated
- **Model 3783 EPC™ Environmental Particle Counter™ Monitor Operation and Service Manual** (part number 6003653) TSI Incorporated
- **Model 3785 Water-based Condensation Particle Counter Operation and Service Manual** (part number 1933001) TSI Incorporated
- **Model 3786 Ultrafine Water-based Condensation Particle Counter Operation and Service Manual** (part number 1930072) TSI Incorporated
- **Model 3787 General Purpose Water-based Condensation Particle Counter Operation and Service Manual** (part number 6003712) TSI Incorporated
- **Model 3788 Nano Water-based Condensation Particle Counter Operation and Service Manual** (part number 6003713) TSI Incorporated
- **Model 3070A Electrical Aerosol Detector Instruction Manual** (part number 1930063) TSI Incorporated
Getting Help

To obtain assistance for this software or to submit suggestions, please contact Particle Instruments:

TSI Incorporated
500 Cardigan Road
Shoreview, MN 55126 USA
Fax: (651) 490-3824
Telephone: 1-800-874-2811 (USA) or (651) 490-2811
E-mail: technical.service@tsi.com

Submitting Comments

TSI values your comments and suggestions on this manual. Please use the comment sheet, on the last page of this manual, to send us your opinion on the manual’s usability, to suggest specific improvements, or to report any technical errors.

If the comment sheet has already been used, mail or fax your comments on another sheet of paper to:

TSI Incorporated
Particle Instruments
500 Cardigan Road
Shoreview, MN 55126
Fax: (651) 490-3824
E-mail Address: particle@tsi.com
CHAPTER 1

Introduction

The Aerosol Instrument Manager® software is used to collect sample data from an instrument and store the sample data in files. You can use the software to display data in graphs and tables, or view statistical information. You can print graphs and tables with the software, and export data for use in other applications.

There are a number of ways to navigate within the program. These include selecting items from the main menus, selecting icons from the toolbar, and selecting items from submenus (which you access by right-clicking the mouse button). Specific instructions are provided in the following chapters.

This manual covers the use of the Aerosol Instrument Manager® software with TSI CPC, EPC™ monitor, WCPC, and EAD instruments only. For information about software operation with other TSI instruments, refer to the appropriate manual.

Particle Concentration and Diameter Concentration

Data is collected from the instrument and stored as either particle concentration (#/cm³) for the CPCs or diameter concentration (mm/cm³) for the EAD.

For Model 3771, 3772, 3775, and 3776 CPCs (Series 3770 CPCs), as well as EPC™ monitor Model 3783, WCPC Models 3787 and 3788, particle concentration is collected every tenth of a second and then averaged for each averaging interval. The particle concentration is live-time corrected for coincidence in CPC models 3771, 3772, and 3776, and in the single-count mode of the 3775 (<50,000 particles/cm³), and in EPC™ monitor model 3783, WCPC models 3787, and 3788. The live-time correction can be turned off using serial commands for the 3772 or 3771 CPC.

For Model 3781, 3785, and 3786 WCPCs, Model 3022A and 3025A CPCs, particle concentration is calculated in two different ways. At low concentrations, single particle counts are summed over each averaging interval, divided by the sample time, and adjusted for the different flow rate of that model CPC. For high concentrations
The concentration (as displayed on the front panel) is collected every second and then averaged for each averaging interval. For the 3010, 3010D, 3760A and 3762 CPC, particle concentration is calculated the same way as for low concentrations in the 3781, 3785, 3786, 3022A and 3025A CPCs.

Model 3775 CPC, 3785 WCPC, and 3022A CPC can measure up to $10^7$ #/cm$^3$ using photometric calibration at high concentrations (>50,000 #/cm$^3$ for 3775; >20,000 #/cm$^3$ for 3785; and >10,000 #/cm$^3$ for 3022A).

For the 3007 CPC, particle concentration is sampled every second and averaged for each averaging interval.

Diameter concentration for the EAD is sampled every second and averaged for each averaging interval.

Refer to individual CPC or EAD manuals for details in concentration calculations.

The following table provides a comparison between CPC, EPC™ monitor, and WCPC models. Operation of the software is similar for all CPC and WCPC models (with slight variations for the Models 3007 and 3781).

<table>
<thead>
<tr>
<th>Model</th>
<th>3007</th>
<th>3771</th>
<th>3772</th>
<th>3775</th>
<th>3776</th>
<th>3781</th>
<th>3783</th>
<th>3785</th>
<th>3786</th>
</tr>
</thead>
<tbody>
<tr>
<td>Minimum particle size (50% efficiency, nm)</td>
<td>10</td>
<td>10</td>
<td>10</td>
<td>4</td>
<td>2.5</td>
<td>6</td>
<td>8</td>
<td>5</td>
<td>2.5</td>
</tr>
<tr>
<td>Aerosol flow rate (cm$^3$/min)</td>
<td>100</td>
<td>1000</td>
<td>1000</td>
<td>300</td>
<td>50</td>
<td>120</td>
<td>120</td>
<td>1000</td>
<td>300</td>
</tr>
<tr>
<td>Upper concentration limit (particles/cm$^3$)</td>
<td>$10^5$</td>
<td>$10^4$</td>
<td>$10^3$</td>
<td>$5 \times 10^4$</td>
<td>$5 \times 10^3$</td>
<td>$10^4$</td>
<td>$2 \times 10^4$</td>
<td>$10^5$</td>
<td></td>
</tr>
<tr>
<td>Lower concentration sensitivity (particles/cm$^3$)</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td>False background counts (particles/cm$^3$)</td>
<td>&lt;0.01</td>
<td>&lt;0.001</td>
<td>&lt;0.001</td>
<td>&lt;0.01</td>
<td>&lt;0.01</td>
<td>&lt;0.001</td>
<td>&lt;0.01</td>
<td>&lt;0.001</td>
<td>&lt;0.01</td>
</tr>
<tr>
<td>Response time (sec for 95% response)</td>
<td>&lt;9</td>
<td>&lt;3</td>
<td>&lt;3</td>
<td>$4^{\dagger}$</td>
<td>$5^{\dagger}$</td>
<td>&lt;2</td>
<td>&lt;3$^{\dagger}$</td>
<td>&lt;5$^{\dagger}$</td>
<td>&lt;2</td>
</tr>
<tr>
<td>Vacuum Source</td>
<td>Internal</td>
<td>External</td>
<td>External</td>
<td>Internal or External</td>
<td>Internal or External</td>
<td>Internal</td>
<td>Internal or External</td>
<td>Internal or External</td>
<td>Internal</td>
</tr>
<tr>
<td>SMPS™ spectrometer compatibility</td>
<td>No</td>
<td>No</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>No</td>
<td>No</td>
<td>Yes</td>
<td>Yes</td>
</tr>
</tbody>
</table>

*Single counting Mode and Photometric Mode
†High flow mode with 1.5 L/min inlet flow
‡Low flow mode with 0.3 L/min inlet flow
§High flow mode with 3 L/min inlet flow
**Low flow mode with 0.6 L/min inlet flow
<table>
<thead>
<tr>
<th>Model</th>
<th>3787</th>
<th>3788</th>
<th>3010D</th>
<th>3010</th>
<th>3022A</th>
<th>3025A</th>
<th>3760A</th>
<th>3762</th>
</tr>
</thead>
<tbody>
<tr>
<td>Minimum particle size (50% efficiency, nm)</td>
<td>5</td>
<td>2.5</td>
<td>23</td>
<td>10</td>
<td>7</td>
<td>3</td>
<td>11</td>
<td>11</td>
</tr>
<tr>
<td>Aerosol flow rate (cm³/min)</td>
<td>100</td>
<td>300</td>
<td>1000</td>
<td>1000</td>
<td>300</td>
<td>30</td>
<td>1500</td>
<td>3000</td>
</tr>
<tr>
<td>Upper concentration limit (particles/cm³)</td>
<td>(10^7)</td>
<td>(10^4)</td>
<td>(10^4)</td>
<td>(10^3)</td>
<td>(10^6)* (10^4)</td>
<td>(10^7)</td>
<td>(10^4)</td>
<td>(5 \times 10^3)</td>
</tr>
<tr>
<td>Lower concentration sensitivity (particles/cm³)</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td>False background counts (particles/cm³)</td>
<td>&lt;0.01</td>
<td>&lt;0.01</td>
<td>&lt;0.0000 1</td>
<td>&lt;0.0000 1</td>
<td>&lt;0.01</td>
<td>&lt;0.01</td>
<td>&lt;0.0000 5</td>
<td>&lt;0.0000 5</td>
</tr>
<tr>
<td>Response time (sec for 95% response)</td>
<td>&lt;2</td>
<td>&lt;1</td>
<td>&lt;5</td>
<td>&lt;5</td>
<td>(&lt;13') &lt;20')</td>
<td>(1') &lt;5')</td>
<td>&lt;3</td>
<td>&lt;1.5</td>
</tr>
<tr>
<td>Vacuum Source</td>
<td>Internal or External</td>
<td>Internal or External</td>
<td>External</td>
<td>External</td>
<td>Internal</td>
<td>Internal</td>
<td>External</td>
<td>External</td>
</tr>
<tr>
<td>SMPS™ spectrometer compatibility</td>
<td>Yes</td>
<td>Yes</td>
<td>No</td>
<td>Yes</td>
<td>Yes</td>
<td>Yes</td>
<td>No</td>
<td>No</td>
</tr>
</tbody>
</table>

This manual assumes you have Microsoft® Windows® XP, Vista® or Windows 7 (32-bit) operating system on your computer and that you are familiar with how Windows® operating system works. If you are not familiar with Windows, please refer to the information that came with it before you load and use this program.

**Notations/Conventions Used in This Manual**

- Throughout this manual when reference is made to “Windows® operating system,” it implies Windows® XP, Vista® or Windows 7 operating system.
- Bold face type is used to indicate that you should perform the indicated action. For example “select the **File** menu” means that you should use the mouse and click on the menu called File.
- When instructions direct you to select items from a menu, a vertical bar (|) is used to separate the items you should select. For example, “select **File | Properties | Settings**” means you should click on the File menu, then select the Properties item, and then select the Settings tab.
- The term “active window” is used to refer to the window that is open on the desktop and is in focus. To verify which window is active, select the **Window** menu and note which item has a checkmark by it. You can make a window active by moving the pointer to that window and clicking the mouse button.

*Microsoft® Windows® is a registered trademark of Microsoft Corporation.

*Windows is a registered trademark of Microsoft Corporation.
CHAPTER 2
Installing the Software

This chapter describes the installation requirements for the Aerosol Instrument Manager® software and the installation procedure.

Note: If the Data Merge software is being used with the Aerosol Instrument Manager® software, it should be installed as listed:

C:\Program Files\tsi\Data Merge Software Module\DataMerge.exe

When installed correctly, Aerosol Instrument Manager® software activates the data merge software and the Data Merge icon appears ( ), on the main toolbar. For more information on the Data Merge software, please refer to the Model 390069 Data Merge Software Module manual (P/N 1930074).

Installation Requirements

To use this software we recommend a personal computer with the following minimum features, components, and software:

- A Pentium® 586 processor or higher.
- A SVGA color monitor.
- Microsoft Windows® XP, Vista®, or Windows® 7 (32-bit) operating system.
- A hard drive large enough to accommodate Windows® operating system, the Aerosol Instrument Manager® software, and data files.

Note: The amount of disk space required depends on the number of samples you collect, the amount of information collected, and the sampling period. After you have collected a number of samples, you may want to look at the file size to estimate how much storage space you will be using.

® Pentium is a registered trademark of Intel Corporation.
® Microsoft® Windows® Vista® and Windows® XP are registered trademarks of Microsoft Corporation.
A CD-ROM drive.

- 256 MB or more of random access memory (RAM).

- A mouse.

- A RS-232 serial interface port or a USB port for each instrument connected (in addition to the one that may be required for the mouse). USB connections are available for Series 3770 CPCs and Series 3780 particle counters.

  Note: Three Series 3770 CPCs can be connected using USB to collect data simultaneously.

- A Microsoft® Windows®-compatible printer is optional.

Installation

Install the Aerosol Instrument Manager® software as follows:

1. Shut down (exit) all programs/applications on the Windows desktop.

2. With the computer on and Windows running, insert the Aerosol Instrument Manager® CD-ROM in your CD drive to run the autorun.exe from the CD.

   a. If AutoPlay is enabled on your PC, the setup program will begin automatically and the introduction screen will be displayed on the Windows desktop.

   b. If AutoPlay is not enabled, select Run from the Start menu and type: D:\autorun (where D is the letter corresponding to your CD drive) in the Open box and press OK.

3. Follow the instructions as the setup program runs. When setup is complete, you will be prompted to read the readme.htm file. You should view the readme.htm file if one is available. This file contains important information that could not be included in this manual. If you decide not to read the file immediately, you can access the file later. It will be installed in the same directory as the application.

4. When the installation program finishes, remove the CD-ROM and store the CD in a safe place for later use.

  Note: Before starting data collection, you may want to set up the monitoring computer to recover from a power failure and to resume data collection. Refer to Chapter 5, “Setting Up for Auto Recovery” for details.
The setup program creates a directory (folder) called “Aerosol Instrument Manager” on your hard disk (assuming you accepted the default directory name). The directory contains the required program files and sample data files.

The setup program also creates a new item in the Start Menu called “TSI” and an icon for the Aerosol Instrument Manager® software.

**Note:** Before creating a TSI menu item, the setup program checks for an existing one. If one is present, it adds the icon only.
CHAPTER 3
Getting Started

This chapter is designed to give you an introduction to the basic operation of the Aerosol Instrument Manager® software. Using it you will:

- Start the program.
- Open an existing file (from the example files provided with the program).
- Change how data is viewed.
- View another sample in the same file.
- Playback (review) the graphs for several data samples in a “slide show” fashion.
- Select a data hot spot.
- Delete/Undelete samples.
- Zoom in and out on data in a graph.
- Print information displayed on the desktop.
- Export data to a file.
- Arrange the windows that are open on the desktop.
- Quit the program.

Start the Program

To start the program, proceed as follows:

From the Windows desktop, using the mouse, double-click the Aerosol Instrument Manager® icon or press the Start menu and select All Programs | TSI | Aerosol Instrument Manager.

The Aerosol Instrument Manager® desktop appears as shown in Figure 3-1.
Open an Existing File

1. Select File | Open… on the toolbar. The “Open Instrument Associated Data Files” window opens.

2. When the “Open Instrument Associated Data Files” window appears, select the correct extension for the file you want to open in the “Files of type” box. For a CPC or an EAD, the file type is .Cxx, where xx indicates the model (for example .C70 is the Model 3070A EAD and .C07 is the Model 3007 CPC).

3. If necessary, browse for the drive/directory where data files are stored. (Example files are included with the program and were installed in the Aerosol Instrument Manager® folder when the program was installed.)
Select the data file that you want to open and click **Open**. At least two windows open on the desktop: a window containing a graph of the sample data, and the Samples List window.

**Note:** If the file has been opened before, it may display more than one graph and/or table. The program remembers the windows that were open on the desktop when you last closed the file and reopens them when you access the file again. If the file contains a sequence of samples, you will be asked if you want to open all the files or just the one you originally chose. See **Appendix C** for information about sequence files.

The Samples List window opens whenever you open a data file and remains open on the desktop as long as the data file is open. Closing the Samples List window closes the data file (and all its open windows).

---

**Change How Data is Viewed**

You can view CPC and EAD data in tables or graphs. The following procedure provides an example of how you can change how data is viewed.

1. Open one of the sample files for a CPC or EAD.

2. With the graph window active on the desktop, open the **Format** menu.

3. Use the mouse to select **Format|Graph Type|Bar**. Notice the change in how data is displayed. (A checkmark next to one of the items in the View menu means that a window for that selection is already open on the desktop. If you select a menu item that is already checked, the window containing that graph or table is brought to the top of the desktop and becomes the active window.)

4. Experiment with other views by making other windows active and selecting other options from the **Format** menu to see how your selections change the data format. Refer to “**Format Menu**” in Chapter 4 for a list of formatting options with detailed explanations.

5. Context-sensitive menus: each view has a context-sensitive menu or “popup” menu which can be opened by holding down the right mouse button. Some of these menu items are described in the Chapter 4 “**Context-Sensitive Menus for Series 3770 CPCs**”. 
**View Another Sample in the Same File**

1. To view another sample in an open file, select the icon (go forward one sample) from the toolbar. The data for the next sample of the currently active file replaces the data in all the open windows.

2. You can continue to step through the samples by pressing the icon until you reach the last sample. The sample currently displayed in the open window is highlighted in the Samples List window.

Another method of changing the sample that is displayed in the open windows on the desktop is by selecting the icon for that sample from the active Samples List window.

You can use the following icons to display other samples:

- **First Sample.** Advance to the first sample.
- **Previous Sample.** Advance to the previous sample.
- **Next Sample.** Advance to the next sample.
- **Last Sample.** Advance to the last sample.

---

**Playback (Review) Data Samples**

You can display sample graphs and tables in a slide show fashion (to preview sample results or compare sample differences) as follows:

1. From the Samples List window, select the samples you want to play back using one of the following actions:

   Select **Sample|Select All**, to play back all samples.

   or

   Select individual samples using the mouse and the Ctrl key to highlight those samples you want to see. (You must select at least two samples.)

   or

   Select a group of samples by holding down the left mouse button and moving the mouse to “rubber band” (outline) the samples you want to select.
**Note:** The Playback menu items and toolbar icons are only enabled when the Samples List Window is the active window and multiple samples are selected.

2. When you have selected the samples you want to view, select **Playback | Play**. The setup box shown in Figure 3-2 appears.

   ![Playback Setup Dialog Box](image)

   **Figure 3-2**
   Playback Setup Dialog Box

3. Select the sample viewing time and whether you want the samples displayed once or continuously. Playback begins immediately. For better viewing, it may be necessary to minimize the Samples List window.

4. You can pause the playback at any time by selecting **Playback | Pause**. Select **Playback | Play** to continue playback where you left off. You can stop playback at any time by selecting **Playback | Stop**. When you stop playback, you cannot restart it. Use **Playback | Pause** and **Playback | Play** if you want to stop and start playback.

You can also control playback by using icons on the toolbar. The icons perform the following operations:

- **Stop**. Stop playback.
- **Pause**. Pause playback on current sample.
- **Start**. Start playback or restart playback.
Select a Data Hot Spot

When a graph is open on the desktop, you can find the values of a data point as follows:

1. Position the pointer on the bar, line, or peak (depending on the type of graph that is active). The pointer becomes a pointing hand.

2. Press the left mouse button to display the values. Figure 3-3 shows how the data values would be displayed for a Model 3775 CPC.

Figure 3-3
Use the Mouse to Directly View Data Values (CPC sample file)

Tip: After you have a data hot spot selected, use the arrow keys or the “>” and “<” keys to move the cursor right or left (from one value to the next), or grab the vertical bar and drag it to another location. Refer to Appendix B for a list of other keys or key combinations you can use to navigate and perform operations without using the mouse.

Delete/Undelete Samples

To delete samples from a file, you must first mark them for deletion and then Save the file. The following procedures will permanently delete samples from a file:

Mark samples for deletion as follows:

1. Select the sample you want to delete from the Samples List window (you can select multiple samples).
2. Select Sample | Delete/Undelete Sample or [X] on the toolbar. The samples will be shown as “Deleted.” However, they will not be permanently removed from the file until you Save the file.

Save the file and permanently delete all samples marked for deletion:

1. With at least one sample marked for deletion in the active file, select File | Save. You will get a message stating: “Some samples have been marked for deletion. Do you want them permanently removed?” Click Yes to remove them or No to keep them.

2. Select Yes. The files marked for deletion are permanently deleted.

Note: A message will appear to remind you to save the file when you close the file or exit the program without saving the file first. If you click Yes, the same message stating “Some samples have been marked for deletion. Do you want them permanently removed?” will appear if some files are marked for deletion. Respond Yes to delete the marked samples and No to close the file without deleting them.

---

**Zoom In and Out on Data in a Graph**

You can zoom in on data displayed in a graph as follows:

1. Use the mouse to position the cursor (pointer) at one corner of the area you want enlarged.

2. Press down on the left mouse button and drag the mouse to the opposite corner of the data you want enlarged.

3. Release the left mouse button. The area you selected is enlarged.

4. You can continue to zoom further by repeating steps 1 through 3.

To Unzoom, select Format | Undo Zoom or [Undo] on the toolbar or press the “z” key in the graph window. The enlarged area is returned to normal view.
Print Information Displayed on the Desktop

You can print the information displayed in the active window on the desktop as follows (you must have a printer properly installed):

1. With a graph or table window active on the desktop, select File | Print Preview or from the toolbar.

2. Review that what you see in the print preview window is what you want to print (an example is shown in Figure 3-4), and then select Print from the Preview box. The contents of the window are sent to your printer.

![Figure 3-4 Print Preview](image-url)
You can immediately print a window without previewing it by selecting **File|Print** or \( \text{print icon} \) from the toolbar.

---

**Export Data to a File**

You can export data from an Aerosol Instrument Manager® file (either a single sample of the file or multiple samples of the file) for use in another program either manually or automatically.

### To Export Data to a File Manually

To manually export data to be used in another program:

1. Select the sample or samples to be exported as follows:
   - To export data from a single sample, display the sample data in an active window on the desktop.
   - To export data from multiple samples, select (highlight) the samples you want to export from the Samples List window.

2. Select **File|Export**. An Export Data Options box similar to the one in Figure 3-5 opens. The export options for the Series 3770 CPCs have options to select certain data types to export.

![Export Data Options Box](image)

**Figure 3-5**

Export Data Options Box for the Series 3770 CPCs
3. Select the data type to be exported. You may export concentration, count and analog input for Series 3770 CPCs.

**Note:** For the other CPC instrument models, you may only select output file type and output file name in this dialog.

4. Select the output file type by choosing the extension for the file you want to export data to. Then you can select from three delimiters: comma, tab, or semicolon. It is recommended to use Tab as the delimiter if you choose .xls as the file extension.

5. Select **Row** or **Column** orientation for the data. Row orientation results in one row for each data sample. Column orientation results in a set of columns for each sample.

6. Select **Time Stamp** or **Elapsed Time** for the time format. When Row orientation is selected, only Elapsed Time is used.

7. If an output file name other than the default is preferred, press the **Save As** button. The system automatically adds the file extension that you have selected to it.

8. Press **OK**.

**To Export Data to a File Automatically**

To export data automatically to a file for use in another program (such as Microsoft® Excel®):

1. Establish a connection to the CPC by choosing **File|New** or **File|Open**.

2. Select **Run|Connect to Instrument** (if not already connected).

3. Select **Run|Auto Export** before you begin to collect data.

4. Select **Run|Start Data Collection**. The data for each sample is automatically exported to the file when it completes.

---

**Arrange Open Windows**

When you have several windows open on the desktop it is helpful to arrange them for easier viewing.

To arrange windows, select an item from the **Window** menu. You can arrange windows on your desktop horizontally, vertically, have them cascade, or arrange them in one of two predetermined auto-fit layouts. Refer to your Windows documentation for examples and more information for Tile horizontal, Tile vertical, and cascade layouts. Press the button (or **Ctrl+L**) in the toolbar for the four-

---

*Microsoft and Excel are registered trademarks of Microsoft Corporation.*
pane layout or press the button (or $\text{Ctrl+K}$) for the two-pane layout as shown in Figure 3-6 for a CPC file.

All of the program windows that are currently open on the desktop are listed at the bottom of the Window menu under the Close All item. To make a window active and bring it to the top of all windows, select the name of the window from the list of open windows.

![Figure 3-6](image)

**Figure 3-6**
Two-Pane Layout of a CPC File

---

**Quit the Program**

To end the program, select File | Exit. All windows and files open on the desktop are closed. If you have made changes to a file and have not yet saved it, you will be prompted to do so.
CHAPTER 4
Software Procedures

Before using the information in this chapter, read Chapter 3. Chapter 3 provides getting started information to help you understand the basics of how the program works.

The subsections of this chapter provide:

- “How To...” information for: setting properties for a CPC, EPC™ monitor, WCPC, or an EAD and how to collect sample data for analysis by the program.
- A description of all menus and menu items available when using a CPC, EPC™ monitor, WCPC, or an EAD (or viewing data files).

How to Set Up Instrument Properties

To access the Properties dialog box for a CPC, EPC™ monitor, WCPC, or an EAD, connect the instrument to the computer (refer to the appropriate instrument manual if necessary) and then select File|Properties or Run|Properties (or Ctrl+R). The software displays the Properties dialog box.

The Properties dialog box displays the following information:

- The initial default properties as set by TSI or
- The properties are recalled from the previous sample when you press the OK button on leaving this dialog.

The Properties dialog box contains three tabs: Scheduling, Settings, and Communications. For the CPC 3007, there are three additional tabs: Log Mode1, Log Modes 2 and 3 and Instrument Clock. Each is described below.
Scheduling Tab

The Scheduling tab lets you select the number of samples, the length of each sample, how often samples are collected, and the start time for the sample. You cannot change the averaging interval for a file that already has data. If you want to change the averaging interval, you must start a new file. Figure 4-1 shows a Properties dialog box showing the Scheduling tab. A description of each parameter follows.

![Figure 4-1](Scheduling Tab of the Properties Dialog Box)

Table 4-1

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Sample length (Sec)</td>
<td>This is the amount of time (in seconds) that data will be collected from the TSI instrument for each sample. The maximum value allowed is 86400 (24 hours).</td>
</tr>
<tr>
<td>Number of Samples</td>
<td>This is the total number of samples you want to collect. The maximum value allowed is 65535.</td>
</tr>
</tbody>
</table>
### Parameter Description

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Total Sample Time</td>
<td>This field is calculated by the software and shows the total sample time based on the values you entered in the Sample Length and Number of Samples boxes. The value is displayed in days, hours, minutes, and seconds. Note that when multiple samples are collected, the total sample time is longer than the Sample Length × Number of Samples. Extra overhead time is needed to open sample data files, transfer and save data, and close data files.</td>
</tr>
<tr>
<td>Averaging Interval (Sec)</td>
<td>This is the number of seconds of data collected that will be averaged together to make up one data point. The number of data points in a sample is equal to the Sample Length/Averaging Interval. The maximum number of data points allowed in each sample is 864,000. For Series 3770 CPCs, EFC™ monitor model 3783, WCPC models 3787, and 3788, the minimum averaging interval is 0.1 second. For all other CPCs and the EAD, the minimum averaging interval is 1 second.</td>
</tr>
<tr>
<td>Scheduled</td>
<td>Select <strong>Only Once</strong> to collect one set of samples. For continuous monitoring, select <strong>Repeat Every</strong> and then select the hours and minutes between samples. Note that extra overhead time is needed for file handling so the time selected for continuous monitoring should be longer than the total sample time which includes overhead time.</td>
</tr>
<tr>
<td>Start At Time</td>
<td>If you don’t check this box, sampling begins as soon as you select <strong>Start Data Collection</strong>. If you want to select a start time, check the box and enter the clock time at which you want sampling to begin. The program uses a 12-hour or 24-hour clock, depending on how your PC is set up. If your PC is set up to use a 12-hour clock, you must indicate if the time is AM or PM by leaving the PM box blank or checking the PM box. The reference time for the program is the time at which your computer is set.</td>
</tr>
</tbody>
</table>

### Files of Sample Sessions That Run Past Midnight

The files for sample sessions that run past midnight are handled differently than those that start and stop on the same date. In this case a sequence of files is created, with each file in the sequence given a unique filename extension identifying its proper order. Appendix C provides a complete description of sequence files including how to access a file that is part of a sequence.

The software provides an auto-save feature for sample times greater than 300 seconds (5 minutes). Intended to prevent data loss in the event of a computer failure, power loss, etc., this feature
automatically writes the sample data to the data file after each 5-minute interval. The maximum data loss is less than 5 minutes.

The Scheduling Tab for EPC™ model 3783, WCPC models 3787 and 3788 gives you the ability to synchronize the instrument clock with the computer clock.

![Figure 4-2](image.png)

**Figure 4-2**
Scheduling Tab for EPC™ Monitor Model 3783, WCPC Models 3787 and 3788

**Table 4-2**
Descriptions of Scheduling Parameters for EPC™ Monitor Model 3783, WCPC Models 3787 and 3788

<table>
<thead>
<tr>
<th>Field/Button</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Sync instrument clock at midnight.</td>
<td>Check this box if you want the software to set the instrument clock to the computer clock time and date at midnight. If a sample is in the process of being collected at midnight, then the sampling will be stopped, the clocks synchronized, and an extra sample will be taken to make up for the one that was interrupted.</td>
</tr>
<tr>
<td>Check Time</td>
<td>Click this button to display the current date and time from the computer and from the instrument. The date is shown in the format month/day/year and the time is shown in 24-hour format as hours:minutes:seconds.</td>
</tr>
</tbody>
</table>
### Field/Button Description

<table>
<thead>
<tr>
<th>Field/Button</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Sync</td>
<td>Click this button to set the instrument clock to the same time as the computer clock and display the current date and time from each.</td>
</tr>
</tbody>
</table>

### Settings Tab

The Settings tab, Figure 4-3, lets you view the instrument ID, add a title for the sample, and include any comments about the sample. The information is displayed when you view the Settings window or when you print out sample results.

![Figure 4-3](image)

The Settings Tab of the Properties Dialog Box

### Log Mode 1 Tab (CPC 3007 only)

Use the Log Mode 1 tab to set up the log intervals used for Log Mode 1. The default values for log intervals are set at 1 second, 1 minute, 5 minutes, 15 minutes and 30 minutes.

Figure 4-4 shows the Log Mode 1 tab. Table 4-2 describes the fields and buttons.
Log Mode 1 Tab of the Properties Dialog for a CPC 3007

Table 4-3
Descriptions for the CPC 3007 Log Mode 1 Tab

<table>
<thead>
<tr>
<th>Field/Button</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>1-5</td>
<td>Enter the log intervals you want to program for Log Mode 1. The log interval is both a frequency and an averaging period. For example, if the log interval is set to 5 minutes, readings are recorded at 5-minute intervals, and each reading is the average value measured over that 5-minute interval.</td>
</tr>
<tr>
<td>Send</td>
<td>After you enter the log intervals you want, select this button to send the values to the CPC.</td>
</tr>
<tr>
<td>Refresh</td>
<td>Select this button to retrieve the values that were last saved for Log Mode 1 in the CPC.</td>
</tr>
<tr>
<td>Default</td>
<td>Select this button to return the log interval values to their default values of 1 second, 1 minute, 5 minutes, 15 minutes, and 30 minutes.</td>
</tr>
</tbody>
</table>

Log Modes 2 and 3 Tab (CPC 3007 only)

Use the Log Modes 2 and 3 tab to set up values for using Log Modes 2 and 3:

Figure 4-5 shows the Log Modes 2 and 3 tab of the Properties dialog box. Table 4-3 provides a description of each field and button.
Figure 4-5
Log Modes 2 and 3 Tab of the Properties Dialog for a CPC 3007

Table 4-4
Descriptions for the CPC 3007 Log Modes 2 and 3 Tab

<table>
<thead>
<tr>
<th>Field/Button</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Serial Number</td>
<td>Displays the serial number of the CPC.</td>
</tr>
<tr>
<td>Available Memory %</td>
<td>Displays the percent of available memory in the CPC.</td>
</tr>
<tr>
<td>Start Date</td>
<td>Enter the date when you want the CPC to begin collecting samples. If you leave this field blank, sampling begins whenever the specified start time occurs.</td>
</tr>
<tr>
<td>Start Time</td>
<td>Enter the time when you want the CPC to begin collecting samples. If you leave this field blank, sampling begins when the operator manually starts the sample. Specify time in 24-hour clock format.</td>
</tr>
<tr>
<td>Log Interval</td>
<td>Enter the log interval. The log interval is both a frequency and an averaging period. For example, if the log interval is set to 5 minutes, readings are recorded at 5-minute intervals, and each reading is the average value measured over that 5-minute interval.</td>
</tr>
<tr>
<td>Sample Length</td>
<td>Enter how long each sample should be collected. If you enter a value, the instrument automatically turns off when the last sample is complete. If you leave it blank, the operator must manually stop the sample collection.</td>
</tr>
<tr>
<td>Number of Samples</td>
<td>Enter the number of samples to collect. Selecting more than one sample causes the instrument to cycle through the sample protocol more than once, separated by the “Time Between Samples.”</td>
</tr>
</tbody>
</table>
### Field/Button Description

<table>
<thead>
<tr>
<th>Field/Button Description</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Time Between Samples (dd:hh:mm)</td>
<td>Enter the time between each sample. If you enter 0 or leave the field blank, the next sample is started immediately after the last sample is complete.</td>
</tr>
<tr>
<td>Percent Memory Required</td>
<td>Displays the percent of CPC memory that will be required to accommodate the data of the protocol you have just entered. If the protocol you have entered requires more than the available memory shown, you will receive a warning message. You cannot specify a sampling protocol that requires more than 100 percent of available memory.</td>
</tr>
<tr>
<td>Send</td>
<td>After you define the sample protocols for Log Mode 2 and/or Log Mode 3, select this button to send the values to the CPC.</td>
</tr>
<tr>
<td>Refresh</td>
<td>Select this button to retrieve the values that were last saved for Log Modes 2 and 3 in the CPC.</td>
</tr>
<tr>
<td>Default</td>
<td>Select this button to return the parameters to their default values.</td>
</tr>
</tbody>
</table>

### Instrument Clock Tab (CPC 3007 only)

In order to be certain the sample start date and time are the values you intend, the instrument data and time should be synchronized with the computer system time and date. Use the Instrument Clock tab (Figure 4-6) to enter the instrument date and time and send it to the CPC.

![Figure 4-6](image)

**Figure 4-6**
Instrument Clock Tab of the CPC 3007 Properties Dialog
Table 4-5 describes the fields and buttons of the Instrument Clock tab.

**Table 4-5**
Descriptions of the CPC 3007 Instrument Clock Tab

<table>
<thead>
<tr>
<th>Field/Button</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>System Date</td>
<td>Displays the computer system’s date.</td>
</tr>
<tr>
<td>System Time</td>
<td>Displays the computer system’s time.</td>
</tr>
<tr>
<td>Instrument Date</td>
<td>Enter the instrument date or use the &gt;&gt; button to transfer the system date.</td>
</tr>
<tr>
<td>Instrument Time</td>
<td>Enter the instrument time or use the &gt;&gt; button to transfer the system time.</td>
</tr>
<tr>
<td>Send</td>
<td>After you enter an instrument time and date, select this button to send the values to the CPC.</td>
</tr>
<tr>
<td>Refresh</td>
<td>Select this button to retrieve the current time values from the CPC.</td>
</tr>
</tbody>
</table>

**Communications Tab**

The Communications tab lets you set up and test the communications port. It is only available when you are connected to an instrument. You can tell you are connected when the New Sample icon is the last icon in the Sample View or you see the text “Connected” in the status bar. Figure 4-7 shows the Communications tab for the EAD and all CPCs except Series 3770 CPCs, EPC™ monitor Model 3783, and WCPC Models 3787 and 3788. Figure 4-8 shows the Communication tab for Series 3770 CPCs, EPC monitor Model 3783, and WCPC Models 3787 and 3788. As shown in Figure 4-8, the Series 3770 CPCs also have USB communication ports available. Table 4-5 describes the fields and buttons of the Communications tab for the EAD and all CPC models.

**Notes:** If you are collecting data and lose communications for more than three seconds, data collection is stopped for the current sample. If you have entered a Repeat Every time on the Scheduling tab, a new sample is collected when the repeat interval occurs (assuming communications has been restored).

The USB communication ports of the Series 3780 particle counters act like serial ports by using a USB driver.
Figure 4-7
The Communications Tab of the Properties Dialog Box for EAD and CPCs except Series 3770 CPCs, EPC™ Monitor Model 3783, and WCPC Models 3787 and 3788.

Figure 4-8
The Communications Tab for Series 3770 CPCs, EPC™ Monitor Model 3783, and WCPC Models 3787 and 3788.
Table 4-6
Descriptions for the Communications Tab

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>On the EAD and all CPCs except Series 3770 CPCs, EPC™ monitor Model 3783, and WCPC Models 3787 and 3788.</strong></td>
<td></td>
</tr>
<tr>
<td>Available Ports</td>
<td>Lists the ports available on your computer system and lets you select the port that is connected to the TSI instrument.</td>
</tr>
<tr>
<td>Test Button</td>
<td>After you select a Com Port, press this button and the software will try to read data from the instrument to verify that you have selected the correct port and have a working connection.</td>
</tr>
<tr>
<td>Test Results</td>
<td>Reports the results of the test, e.g., whether the instrument is connected to the computer or not</td>
</tr>
<tr>
<td><strong>On Series 3770 CPCs, EPC™ monitor Model 3783, and WCPC Models 3787 and 3788.</strong></td>
<td></td>
</tr>
<tr>
<td>Port</td>
<td>List of available ports.</td>
</tr>
<tr>
<td>Instrument</td>
<td>Model number of the CPC connected to the computer.</td>
</tr>
<tr>
<td>Serial No.</td>
<td>Serial number of the CPC connected to the computer.</td>
</tr>
<tr>
<td>Version</td>
<td>Version number of firmware.</td>
</tr>
<tr>
<td>Status</td>
<td>Status of the connection, if connected or not.</td>
</tr>
</tbody>
</table>

How To Collect Sample Data

All CPC, WCPC models, and the EAD allow you to collect data directly from the instrument as it is sampled. Additionally, the Model 3007 CPC allows for remote data sampling which can be downloaded to the Aerosol Instrument Manager® software as desired. Both methods of collecting sample data are described below.

Collecting Sample Data

To collect data from a CPC, WCPC, or EAD, proceed as follows:

1. Make certain the instrument is connected properly to the computer. Refer to the instrument manual if necessary.

2. Select File | New or ☐ on the toolbar. The New Instrument and Associated Data File dialog box opens on your desktop.

3. Select a filename (and, optionally, a location other than the Aerosol Instrument Manager® folder). The default name is “AIM1” for the first file you open, “AIM2” for the second file you
open and so on. You can accept the default name or enter any name you choose.

4. Verify that the “Files of Type” box indicates the correct extension for the instrument you are using (the extension indicates the correct instrument model number, for example, .C75 for a Model 3775 CPC). You do not need to enter an extension in the filename box. It will be automatically assigned the extension that you selected.

5. After you enter a filename (or if you accept the default name) press the Open button.

If you get the following error message when opening a New file, press the OK button to open the Properties dialog box.

![Communications Error](Image)

Use the Communications Tab to verify the connection to the instrument and make certain the instrument is turned on.

Once the program connects with the instrument, a Samples List window and a Data Graph window open on the desktop.

6. Select Run|Start Data Collection or on the toolbar. Sampling will proceed as set up in the Properties dialog box.

When the program begins collecting sample data, the data is displayed in the windows that are open on the desktop.

As each sample finishes, the data for the sample is stored and a new sample begins. When the last sample finishes, sampling stops, but the windows remain open.

7. View, print and export the sample data using procedures described in Chapter 3.

### Downloading Remotely Sampled Data from the CPC Model 3007

After you have collected data with the Model 3007 CPC, you can download the data to the program for analysis.

To download data from the Model 3007 CPC to the computer, proceed as follows:

1. Make certain the CPC is connected properly to the computer. Refer to the instrument manual if needed.

2. Select File|New or on the toolbar. The New Instrument and Associated Data Files dialog box opens on your desktop.
3. Select a filename (and, optionally, a location other than the Aerosol Instrument Manager® folder). The default name is “AIM1” for the first file you open, “AIM2” for the second file you open, and so on. You can accept the default name or enter any name you choose.

4. Verify that the “Files of Type” box indicates the correct extension for the instrument you are using (.C07 for a Model 3007 CPC). You do not need to enter an extension in the filename box. It will be assigned automatically.

5. After you enter a filename (or if you accept the default name) press the **Open** button.

   If you get the following error message when opening a New file, press the **OK** button. This will open the Communications Tab of the Properties dialog box.

   ![Communications Error](image)

   Verify the connection to the instrument and make certain the instrument is turned on.

   Once the program connects with the CPC, a Samples List window and a Data Graph window open on the desktop.

6. Select **Run|Receive Logged Data**. The Receive Samples From Instrument dialog box appears.

   ![Receive Samples From Instrument](image)
7. The dialog lets you select the samples you want to download. (The number of samples depends on the settings selected for Log Modes 2 and 3.)

You can receive (download) one sample at a time by highlighting the sample or you can also receive (download) several samples at a time by highlighting one sample and then holding down the Ctrl key and selecting other samples. You can also click the **Select All** button to highlight all samples.

8. After you select the sample or samples to download, click the **Receive** button. The sample data is downloaded into the open file.

9. View, print and export the sample data using procedures described in **Chapter 3**.

10. After you have downloaded the data from the Model 3007, you can clear the instrument’s memory by selecting **Run | Clear Instrument Memory**.

---

**Import Data from Flash Memory Card for Series 3770 CPCs**

The Series 3770 CPCs can collect sample data onto a removable flash memory card. Using a flash memory card docking station (available in CPC accessory kit), sample data saved on the card can be imported into the Aerosol Instrument Manager® software and viewed and displayed using the various features offered by the software. Follow the steps below to import the sample data into the software. See the individual CPC instrument manual for a description of the series 3770 CPC data files.

**Notes:** *Data files can be moved from Flash memory card to another storage device without using the import utility. The import utility imports data files from any valid path. The files on the card can be managed through Windows tools.*

*It is recommended using a unique flash memory card for each instrument to avoid that sample files from different instruments are mixed together.*

*Floating information tool tips are available over most active buttons and List boxes. For the List of Logged CPC Data Files Box, for example, the tool tips show the whole sample file names without the need to use the horizontal scroll bar when file names are long.*
1. Make sure the flash memory card docking station is connected to the USB port of the computer on which the Aerosol Instrument Manager® software is installed and running. Insert the flash memory card into the docking station.

2. Select **File | Import | Series 3770 Data Files** ... from the main Aerosol Instrument Manager **File** menu when no data file is open or select **File | Import Series 3770 Data Files** ... from the **File** menu when a Series 3770 CPC data file is open. This option is inactive when a file other than Series 3770 CPC data file is opened in the software. The **Import Series 3770 CPC Data Files** dialog box opens.

3. Use the **Browse** ... button to locate and select the sample files on the flash memory card or another storage location. The selected sample files will appear in the **List of Logged CPC Data Files** as shown in Figure 4-9.

![Import Series 3770 CPC Data Files Dialog Box](image-url)
**Note:** If sample files from more than one directory need to be added to the list, use the **Browse** button again. New sample files will be appended to the bottom of the list.

4. Select data files from the logged data file list. The import utility only imports the selected files. The initial default is to have all the data files selected for import. Use the mouse and Ctrl key to select just a subset of the files that you want to import.

**Note:** The order of imported samples in the Aerosol Instrument Manager® data file is determined by the order of selection of the logged data files in the **List of Logged CPC Data Files** window. Select multiple logged data files in the order you want using the mouse and Ctrl key.

5. Add **Sample Properties (optional)**. Specify a **Title** and **Comment** to be added to every new sample in the selected Aerosol Instrument Manager® file. The **Instrument ID** will be automatically read from each data file and added to each imported sample.

6. Use **Save As** button to bring up the **Select a New or an Existing Data File** window to put in the Aerosol Instrument Manager® file name that will be used to save the imported sample data files. If a new file name is selected, a new Aerosol Instrument Manager® file will be created. If an existing file of the correct type (instrument type and data averaging interval match) is selected, then the new series 3770 data is appended as new samples in the existing file.
Import of the data files begins automatically when the Save button is pressed. Each logged Series 3770 CPC file is imported as a sample into the selected Aerosol Instrument Manager® file.

**Notes:** Samples that have different data averaging intervals cannot be imported into one Aerosol Instrument Manager® file. When imported to a new file, samples that have a different averaging interval than the first selected sample are skipped and not imported, even if they are selected. When imported and appended to an existing file, samples that have a different averaging interval than the existing file are skipped and not imported.

Only samples from the same CPC model can be imported to one Aerosol Instrument Manager® file. When imported to a new file, samples from a different CPC model than the first selected sample are skipped and not imported. When imported and appended to an existing file, samples from a different CPC model than the existing file are skipped and not imported.

Sample files from instruments that are the same model can be imported into one Aerosol Instrument Manager® data file. The serial number is recorded in each sample in the file. To avoid mixing data from CPCs with different serial numbers, use one flash memory card for each instrument!
7. **Message line.** There is a line of general information text at the bottom of the Import dialog box. It provides information on status of the import and displays (2 sec) logged samples that are skipped during conversion, etc.

8. If the 3770 Import dialog is opened when no data file is open in Aerosol Instrument Manager® software, after logged data files from the memory card are imported, and the **OK** button is pressed, the Import dialog box closes and the imported Aerosol Instrument Manager® file opens. If **Cancel** button is pressed, the dialog box simply closes. Select **File|Open** to open the imported Aerosol Instrument Manager® file.

With a Series 3770 CPC data file open in Aerosol Instrument Manager® software, after data files from flash memory card are imported, and the **OK** or **Cancel** button is pressed, the Import dialog box simply closes. Select **File|Open** to open the Aerosol Instrument Manager® data file with the samples imported from the flash memory card.

---

**Import Data from USB Flash Memory Stick for EPC™ Monitor Model 3783, and WCPC Models 3787 and 3788**

EPC™ Environmental Particle Counter™ monitor Model 3783 and Water-based Condensation Particle Counter Models 3787 and 3788 can collect sample data onto a removable USB flash memory stick. The sample data saved on the USB memory stick can be imported into the Aerosol Instrument Manager® software and viewed and displayed using the various features offered by the software. Follow the steps below to import the sample data into the software:

1. Plug the flash memory stick into a USB port on the computer to transfer the files to the computer or directly import the files into the Aerosol Instrument Manager® software.

2. Select **File|Import|EPC 3783 or WCPC 3787, 3788 Data Files** from the main Aerosol Instrument Manager® software **File** menu when no data file is open or select **File|Import EPC 3783 or WCPC 3787, 3788 Data Files** from the **File** menu when an EPC™ monitor Model 3783, and WCPC Models 3787 or 3788 data file is open. This option is inactive when a file for a different WCPC model is opened in the software. The **Import 3783, 3787, or 3788 CPC Data Files** dialog box opens.

3. Follow steps 3 through 8 in the section **Import Data from Flash Memory Card for Series 3770 CPCs** since the dialog looks the same as the one described in that section.
Model 3781 WCPC Data Import and Logging

The 3781 WCPC can be set to log data to its internal memory chip and download the logged data using the Aerosol Instrument Manager® software or RS-232 commands through a terminal program. When using the Aerosol Instrument Manager® software, the data can be downloaded either into the software or as a text file.

Note: Floating information tool tips are available over most active buttons. Select File|3781 WCPC Import/Logging from the main Aerosol Instrument Manager® File menu. This option is inactive if a data file other than the 3781 WCPC data file is opened in the software.

![3781 WCPC Import / Logging Dialog Box](image)

**Available Memory:** 98%  **Samples:** 9

**Read Memory**

**Log Start:** Thursday, April 27, 2006 16:37:17  **Log Stop:** Monday, May 01, 2006 15:49:27

**Sample Properties**

**Title:** This title will be added to each sample

**Instrument ID:** Model 3781 Ver 1.01 SN#9810000

**Comment:** This Comment will be added to each sample

Logged Data can be Saved as "*.txt" or "*.CSV" files.

![3781 WCPC Import/Logging Dialog Box](image)

**Figure 4-11**

3781 WCPC Import/Logging Dialog Box

1. **Read Memory** uploads the 3781 logged data, which is streamed data in the 3781 internal memory chip. When the data is
uploaded, it is sorted into samples based on whether the data logging was stopped in between. In the dialog box, each sample displays the sample number, the number of data records in the sample, the data averaging interval, the time the sample started data logging and the time that the sample stopped logging. The Import utility only imports the selected data samples. By default all samples read from the memory are initially selected. Use the mouse and Ctrl key to select just a subset of the samples that you want to convert.

2. **Available Memory** is the amount of memory in percentage left in the internal memory chip in the 3781 WCPC. The maximum number of records is 24,567.

3. **Samples** is the number of sample periods found in the stream-logged data. A sample is defined as a set of records that have the same data averaging interval and the time period between every two records matches that averaging interval. For example: if the data averaging interval is 1 second, then to be included in the same sample, every time-stamped record must be one second removed from the previous record. Stopping and restarting data logging will effectively close one sample and begin a new sample.

4. **Log Start and Log Stop** cover the entire span of data records logged in the 3781 WCPC. Log Start is the start time stamp of the first record in the memory chip, and Log Stop is the stop time stamp of the last record in the memory chip.

5. **Sample Properties (optional).** Specify a **Title** and **Comment** to be added to every new sample in the selected Aerosol Instrument Manager® file. The **Instrument ID** will be automatically read from each data file and added to each imported sample.

6. **Save As.** Save records in an Aerosol Instrument Manager® data file or in a text file. When this button is pressed, a **Save As** window appears to select the file type and input the file name to save the data.

   a. **Aerosol Instrument Manager data file:** Select the Aerosol Instrument Manager® data file name to which to store the imported samples. The default file name is based on the Model Number, Serial Number, Date and Time. For example: 3781_SN_9850000_Apr03_2006_10 09 15.C81. If an existing Aerosol Instrument Manager® data file is selected (and the instrument type and data averaging interval match), the logged data files are imported and appended as new samples to the file. If a new Aerosol Instrument Manager® data file is selected, the logged data files are imported as samples to the newly created file.
Note: Samples that have different data averaging intervals cannot be imported into one Aerosol Instrument Manager® data file. When imported into a new file, samples that have a different averaging interval than the first selected sample are skipped and not imported, even when they are selected. When imported and appended to an existing file, samples that have a different averaging interval than the existing file are skipped and not imported. The existing file selected should be a 3781 WCPC data file and have an extension of .C81.

If the data samples saved are from multiple days, the Aerosol Instrument Manager® file saved will be a sequence file. See Appendix C “Sequence Files” for more information.

b. Text file. Only the records in the selected samples will be saved in the file. The default file name is based on the Model Number, Serial Number, Date and Time. For example: 3781_SN_9850000_Apr03_2006_10_09_15.dat. The data file will have the following format:

```
Instrument ID : Model 3781 Ver 1.00 S/N 9850000
Title :
Comment :
Time,Flags,Concentration,Sample Interval,Live
Time,Count,AP,FL
2006/04/13 15:09:15,0,1.53e4,1,0.946,29073,994,120
2006/04/13 15:09:16,0,1.43e4,1,0.944,27116,999,121
~~
~~
```

7. Message line. There is a line of general information text that appears just below the File Name Group Box. It provides information on the status of the import and displays (2 sec) logged samples that are skipped during conversion, etc.
8. Press **Logging** button at the bottom of the **3781 WCPC Import/Logging** dialog box to bring up the Logging dialog box. The Logging indicator at the side of the **Logging** button shows whether the data logging is on or off. A blank indicator means that it is unknown whether data logging is on or off.

![Logging dialog box](image)

**Figure 4-12**

3781 WCPC Data Logging Dialog Box

- **Data logging on**
- **Data logging off**
- **Unknown status**

9. **Check Time.** Reads the current time from the computer and the current time from the 3781 WCPC and displays the two times in the same format.

10. **Synchronize.** Sets the current time of the 3781 WCPC to match the current time of the computer. Re-reads the two times and displays them. They should match to the second after synchronization.

    **Note:** Time between the computer and the 3781 WCPC can drift a few seconds a day.

11. **Start.** Begins data logging at the given data averaging interval (1 to 300 seconds). All intervals are in integer seconds.

12. **Stop.** Stops data logging immediately.
13. **Clear Memory.** Brings up a message box. Click **Yes** to erase **ALL** logged data currently stored in the internal memory chip in the 3781 WCPC.

![Figure 4-13](image)

**Clear Memory will Erase ALL of the Logged Data in the 3781 WCPC**

14. **Exit.** Returns back to the 3781 WCPC Import/Logging dialog box.

**Notes:** If the 3781 WCPC is logging data, “Read Memory” button is inactive.

*When data logging is on, start collecting data (and Instrument Status) with Aerosol Instrument Manager® software stops the internal data logging. The two data collection methods should not be used simultaneously.*

*If logging is active, a message box will allow a choice to continue or not.*

![Figure 4-14](image)

**3781 WCPC Currently Logging, Collecting Data Dialog Box**

---

**Active Menus**

This section describes the various functions available for a CPC or an EAD through the menus on the Aerosol Instrument Manager® desktop. The Menus include: File, Run, Playback, Format, View, Sample, Window, and Help.

Which menus are available depends on the operation you are currently performing on the desktop.
In addition to the menus, a toolbar (located just beneath the desktop menus) is available to provide shortcuts to many of the functions in the menus. You can hide the toolbar if you want to enlarge the desktop, see the description of the View Menu, below.

**Note:** All menus and the menu items are described below. Depending on the operation you are currently performing and the window that is active on the desktop, the menu may appear different than shown, i.e., some menu items may not be available.

**File Menu**

The items of the File menu are used to open, save, and recall files and perform other program operations. Figure 4-15 shows the File Menu options for the EAD and all CPCs, EPC™ monitor, and WCPCs.

<table>
<thead>
<tr>
<th>File</th>
<th>Run</th>
<th>Playback</th>
<th>Format</th>
<th>View</th>
<th>Sample</th>
<th>Window</th>
<th>Help</th>
</tr>
</thead>
<tbody>
<tr>
<td>New</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Open</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Close</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Save</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Save As...</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Import Series 3770 Data Files...</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>3781 WCPC Import/Logging...</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Export...</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Properties...</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Print...</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Print Preview</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Print Setup...</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>1_3781_SN_S810001_Apr27_2006_11 37 17.5:C81</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>2 1sec:C81</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Exit</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

**Figure 4-15**

File Menu Options for EAD and all CPCs, EPC™ monitor, and WCPCs

**New**

Select **File | New** or [ ] on the toolbar to open a new file and prepare to collect sample data.

After you select **New**, you are prompted to enter a filename. Accept the default filename or enter any filename you chose, then select **OK**.
A four-pane window layout including the samples list window and graph window will open on the desktop with the filename you entered and you are ready to start collecting data. Refer to "How to Collect Sample Data" earlier in this chapter for a complete description.

Open

Select File|Open or on the toolbar to open an existing file. By default, sample files are stored in the same directory as the Aerosol Instrument Manager® program. All files will automatically be given the appropriate filename extension according to the instrument model you are using (see above description). If you store data files in another directory or on another drive, you must first display the file pathname in the Open window before you can select and open it.

Note: When opening files for sample sessions that run past midnight, refer to the description of Sequence Files in Appendix C and for information on how the files are opened.

When the file opens, a window opens on the Aerosol Instrument Manager® desktop containing data from the first sample in the file.

You can have many samples and many files open on the desktop at the same time. Only one window, however, is the active window.

Close

Select File|Close or on the toolbar to close a file (and all the windows associated with it). If there are windows open on the desktop from more than one file, Close will close only those windows associated with the file whose window is currently active.

If you attempt to close a file that has been changed but not saved, you will be prompted to save the changes before closing the file.

If you have marked a sample or samples for deletion, but have not saved the file, you will get the following message: “Some samples have been marked for deletion. Do you want them permanently removed?” If you click Yes the samples marked for deletion are permanently deleted. If you click No the samples marked for deletion are not deleted. They are saved, and are no longer marked for deletion.

Save

Select File|Save or on the toolbar to save sample data to a file.
If you have marked a sample or samples for deletion, but have not saved the file, you will get the following message: “Some samples have been marked for deletion. Do you want them permanently removed?” If you click **Yes** the samples marked for deletion are permanently deleted. If you click **No** the samples marked for deletion are not deleted. They are saved, and are no longer marked for deletion.

**Save As**

Select **File|Save As** to save data in an existing file to a new filename. (The file contents are duplicated to the new filename. If you want to delete the original filename, use Windows® Internet Explorer® browser to do so.)

After you select **Save As**, you can select a drive/directory. You can use the same filename if you save the file to another drive/directory, but if you want to save the file to the same directory, you must give it a new name.

Do **not** add the filename extension. It is added automatically when you select **Save**.

**Import Series 3770 Data Files...**

Select **File|Import series 3770 Data Files...** to import and convert data from a Flash Memory Card. Refer to “Import Data from Flash Memory Card for Series 3770 CPCs” earlier in this chapter for details. This option is inactive when a file that is not from Series 3770 CPCs is open in the software.

**Import 3783 EPC™ Monitor, and WCPC 3787 and 3788 Data Files...**

Select **File|Import|EPC 3783 or WCPC 3787, 3788 Data Files...** to import and convert data from a USB Flash Memory Stick. Refer to “Import Data from USB Flash Memory Stick for EPC™ Monitor Model 3783, and WCPC Models 3787 and 3788” earlier in this chapter for details. This option is not present when a file that is not from one of these WCPCs is open in the software.

**3781 WCPC Data Import and Logging**

Select **File|3781 WCPC Import/Logging** to import logged data from a 3781 WCPC. Refer to “Model 3781 WCPC Data Import and Logging” earlier in this chapter for details. This option is inactive when a file that is not from 3781 WCPC is open in the software.
Export

Select **File|Export** to export data (either a single sample or multiple samples in a file) for use in another program. Data is exported in a delimited excel, csv, or text file. Refer to “Export Data to a File” in Chapter 3 for information.

Properties...

Select **File|Properties** to set the sample properties and view the Communications parameters used by the Aerosol Instrument Manager® software. The parameters that can be set for each instrument on each tab are described in “How to Set Up Instrument Properties” earlier in this chapter.

Print

Select **File|Print** or 📑 to print the active window on the desktop in a report format. If you want to preview the output before printing it, select **File|Print Preview** or 📑.

Refer to your Windows documentation for information about the Print dialog box.

Print Preview

To avoid printing something you don’t want, select **File|Print Preview** or 📑 to see what your printed output will look like before selecting Print.

Print Setup

Select **File|Print Setup** to set up the printer for printing. Refer to your Windows documentation and your printer’s documentation for information about setting the printer parameters.

List of Recently Accessed Files

Between the Printer Setup and Exit menu items is a list of the most recently accessed data files (a maximum of four files is displayed). These are accessed from the menu by selecting **File|1, 2, 3, or 4**.

The list provides a shortcut to these files so you can bypass the Open command. To open one of the files listed, use the mouse to highlight it and then click the left mouse button. The file opens on the desktop.
Exit

Select **File|Exit** to end the program.

Run Menu

The items available under the Run menu are used to start and stop data collection.

![Run Menu](image)

**Figure 4-16**
Run Menu for (A) EAD and All CPCs except CPC 3007; (B) Model 3007 CPC

Start Data Collection

With a new file open on the desktop, select **Run|Start Data Collection** or **Start** on the toolbar to begin collecting sample data. Samples are collected according to the sample length, number of samples, scheduled times, averaging interval, and other parameters set in the tabs of the Properties dialog (see earlier in this chapter).

*Note: If a start time is set, this menu item (and its associated icon) is disabled.*

Once you select **Start Data Collection**, sampling begins immediately or starts at the scheduled time. As data is collected, it is displayed in the open windows.

Finish Current Sample

Select **Run|Finish Current Sample** when you want to stop collecting sample data prematurely. (Before all samples have ended as set in the Properties dialog.) When you select this item, the current sample is allowed to finish before sampling ends.
Stop Current Sample

Select Run | Stop Current Sample or  on the toolbar when you want to stop collecting sample data immediately. When you select this item, sampling stops and data collected to this point is stored in the data file.

Abort Current Sample

Select Run | Abort Current Sample when you want to abort data collection. Aerosol Instrument Manager® automatically saves the data to the file after 5 minutes of sampling, therefore, once data has been written to the file, this menu item is unavailable. You must stop the current sample and then delete the sample (see description under Sample Menu) in order to discard the data. Otherwise, selecting this item prior to 5 minutes of sample time, stops sampling and the data for the current sample is discarded.

Connect to Instrument

Select Run | Connect to Instrument to connect the software to the CPC, EPC™ monitor, WCPC, or EAD. You must connect before you can download data or begin sampling. When you select File | New, the software automatically connects to the CPC, EPC™ monitor, WCPC, or EAD.

Disconnect from Instrument

Select Run | Disconnect from Instrument to disconnect the software from the CPC, EPC™ monitor, WCPC, or the EAD.

Receive Logged Data (CPC 3007 only)

Select Run | Receive Logged Data to begin downloading data from the Model 3007 CPC. Select this menu item to download previously logged sample data from the CPC.

Clear Instrument Memory (CPC 3007 only)

Select Run | Clear Instrument Memory to clear all previously logged sample data from the Model 3007 CPC’s memory.

Auto Export ...

Select Run | Auto Export... to automatically export data for use in another program. Refer to “Export Data to a File” in Chapter 3 for additional information.
Properties…

This menu item provides a shortcut to the same Properties menu item listed under the File menu and appears here for convenience.

Select Run | Properties (or Ctrl+R) to display the Properties dialog that lets you set the parameters used by the Aerosol Instrument Manager® software to collect sample data.

The parameters that can be set are described earlier in this chapter.

Playback Menu

The Playback menu appears only when a Samples List window is active on the desktop. Its purpose is to allow you to display graphic and table windows in series, like a slide show, so that you can compare samples or view a series of samples.

Refer to “Playback (Review) Data Samples” in Chapter 3 for instructions.

Play

Select Playback | Play or from the toolbar to display the control window for playing the samples you selected. First select the time you want each sample displayed (full speed, 0.5, 1.0, 2.5 or 5.0 seconds). Then select whether to view the samples once or continuously. As soon as you select Play Once or Play Continuously, the open views for the first sample you selected are displayed for the specified time period, then the views for the second sample are displayed, and so on until all the samples selected have been displayed. If you selected Play Continuous from the Playback Setup dialog box, the series repeats itself indefinitely.

Pause

Select Playback | Pause or from the toolbar to interrupt the playback of the samples. This feature lets you stop playback to view the data of an interesting sample without canceling the playback of
all selected samples. When you want to start playback again, select **Playback|Play**.

**Stop**

Select **Playback|Stop** or from the toolbar to end sample playback before all samples have been displayed. If you select Stop and you want to restart sampling, you must select **Playback|Play**, select the display time for each sample, and begin displaying samples from the first selected sample.

**Format Menu**

The Format menu has several variations depending on the active window. The menu items of the Format menu let you control how information is presented in tables and graphs including: graph type, grid lines, font, color, etc., when a graph or table window is active. When a Samples List window is active on the desktop, the menu items of the Format menu let you determine how items in the Samples List window are displayed. You can select large or small icons, or list the samples with or without details. Details include: date, pathname, and title of the sample.

When a window is active on the desktop, you can display the Format menu items (plus other menu items) by placing the cursor in the window and clicking the right mouse button.

![Format Menu](image)

*(A) (B)* Figure 4-18 Format Menu (A) When A Graph Window Is Active; (B) When A Samples List Window Is Active

**Y Axis**

This menu item is available only when a graph window is active on the desktop.
Select **Format | Y Axis** to select the way the Y axis is displayed, see Figure 4-19. By default, the graphs display in normal/auto scale. You can select Auto or Fixed scale and either log or normal scale. To display in logarithmic scale, check the **Log Scale** box.

If you select **Fixed Scale**, you must enter a minimum and/or maximum number (you do not need to enter both).

![Y Axis Dialog Box](image)

**Figure 4-19**
The Y-Axis Dialog Box

**Display View Boundaries**

Select **Format | Display View Boundaries** to display the View Boundaries. Move the mouse pointer along the data set, when the pointer turns into a “hand,” use the mouse pointer to drag the boundaries to the desired location. View boundaries are active only if checked.

**Notes**: If the View Boundaries are active and a View Boundary is not visible on the left, move the mouse cursor to the far left edge of the chart and drag it to a displayable part of the chart.

If the chart is zoomed, the view boundaries may not be shown on the chart without scrolling.

**Graph Type**

Select **Format | Graph Type** to select the type of graph to display in the active window. The options are bar, line, area or points plus line. If the Graph toolbar is visible, you can select the option using the appropriate icon.

- Display graphs using bars.
- Display graphs using lines.
- Display graphs showing area.
Grid Lines

Select **Format | Grid Lines** to select the lines for the graph in the active window. The options are horizontal, vertical, both or none. If the Graph toolbar is visible, you can select the option using the appropriate icon.

- Display graphs with no grid.
- Display graphs with a horizontal grid.
- Display graphs with a vertical grid.
- Display graphs with both horizontal and vertical grids.

Color

Select **Format | Color** or ![color icon] from the toolbar to change the colors used to display items in the active window.

When you select **Format | Color**, the Graph Color or Table Color window opens depending on the active window on the desktop (Figure 4-20 shows both). These windows include a preview screen, a drop down list and a color palette. From the drop down list, select the name of the item you want to modify. The current color for that item is indicated in the color palette. Use the mouse to point to the new color for that item and click the left mouse button to select it. The preview screen then displays the item in the new color.

Select items from the drop down list and colors as desired. When finished, press **OK**: the colors you selected will be used from that point on in all graphs and/or tables.
The items you can select for windows containing graphs are:

- Window Background
- Plot Area Background
- Labels
- Axis
- Data
- View Boundaries
- Data Hotspot Lines

The items you can select for windows containing tables are:

- Window Background
- Cell Text
- Grid Color
- Cell Background
- Fixed Area Text

Figure 4-20
(A) The Graph Color Dialog Box; (B) The Table Color Dialog Box
Font

Select the **Format|Font** menu or \[\textcolor{red}{\text_ylim}\] from the toolbar to change the style and size of the text in all graphs or tables.

Select **Format|Font|Style**... to select a new font or change the font style, see Figure 4-21. You can select any font and font style available on your computer. The preview box lets you see what the text will look like before you implement it by selecting **OK**.

![Font Dialog Box](image)

**Figure 4-21**
Font Dialog Box

To change the font size, select **Format|Font|Small**, **Medium**, or **Large** (the default is Medium). To change the text size without using the menus, select the \[\textcolor{red}{\text_ylim}\] icon from the toolbar. Each time you select the icon the text size changes to the next text size. (Rotation is from small to medium to large.)

### Undo Zoom

Select **Format|Undo Zoom** to return a graph to its “normal” viewing size after you have zoomed in on a portion of the graph. See “Zoom In and Out on Data in a Graph” in Chapter 3.

### View Menu

The list of items in the View menu depends on which windows are open on the desktop and which one is active. The View menu lets you select the sample windows to open on the desktop and select parameters to view in those windows. A checkmark next to an item indicates the item has already been selected. Look under the Windows menu to find the item and make it the active window.
Graph

Select **View|Graph** to open a graph window that displays the file’s sample data based on particle concentration or diameter concentration (for the EAD).

Table

Select **View|Table** to open a table window that displays the file’s sample data based on particle concentration or diameter concentration (EAD).

Statistics

Select **View|Statistics** to open a window of statistical information for the active sample.

Settings

Select **View|Settings** to view the settings for the current sample.

Instrument Status ...

Select **View|Instrument Status** to display a dialog window displaying status information for the CPC, EPC™ monitor, WCPC, or EAD. The information in this dialog is updated every two seconds until the dialog is closed. Refer to the instrument manual for your CPC, EPC™ monitor, WCPC, or EAD for an explanation of items shown in this dialog.

This option is not available for the Model 3007 CPC.
Copy

Select View|Copy or from the toolbar to copy the active window to the clipboard so that you can “paste” it in other applications, for example a word processing program. You can only copy tables and graphs.

Toolbars

Select View|Toolbars to display or hide the toolbars that appear on the desktop. Each toolbar is illustrated below:

- **Main Toolbar**
- **Color and Font Toolbar**
- **Graph Toolbar**
- **Navigation Toolbar**

The Merge icon appears on the main toolbar if the appropriate software (Data Merge Software) has been installed. See Chapter 2, “Installing the Software” for more information.

By default, only the Main and Navigation toolbars are displayed.

To view what each icon (tool) does, position the cursor on the icon. A balloon will appear to describe the function of the icon.

Toolbars can be moved and resized if desired. To move a toolbar, position the cursor on a gap between two toolbars and press and hold the left mouse button. As you move the mouse, the toolbar moves with it. To resize a toolbar, position the cursor at an edge or corner of the toolbar window that you have moved and resize it as desired. You can hide a toolbar by selecting the “x” in the upper right corner.

Sample Menu

The Sample menu lets you navigate through files with multiple samples.
**Note:** You can also navigate through files with multiple samples using the Navigation toolbar.

### Beginning Sample
Select **Sample|Beginning Sample** or from the toolbar to display the data for the first sample of the file in the active window.

### Previous Sample
Select **Sample|Previous Sample** or from the toolbar to display the data for the previous sample of the file in the active window.

### Next Sample
Select **Sample|Next Sample** or from the toolbar to display the data for the next sample of the file in the active window.

### Ending Sample
Select **Sample|Ending Sample** or from the toolbar to display the data for the last sample of the file in the active window.

### Delete/Undelete Sample
Select **Sample|Delete/Undelete Sample** or from the toolbar to mark a sample for deletion or to unmark a sample that has been previously marked for deletion. Sample data that is marked as deleted are not physically deleted from the file until you select **File|Save**.

### Select All
Select **Sample|Select All** to select (highlight) all samples in the Samples List window for playback or exporting. This item is only available when the Samples List window is the active window.
Window Menu

The Window menu items let you open, close and arrange the windows on your desktop. Refer to “Arrange Open Windows” in Chapter 3 and your Windows documentation for an example of what each command does.

All windows on the desktop, whether active or inactive, are listed after the Close All command; the active window is shown with a check mark. To make a different window active and bring it to the front, select it with the mouse.

Help Menu

The Help menu provides access to information about the program.

About Aerosol Instrument Manager

Select Help | About Aerosol Instrument Manager to see the copyright statement for the program and view the version number of the software.

Help Manual

Select Help | Help Manual to see the manual of the Aerosol Instrument Manager® software for CPC, EPC™ monitor, WCPC, and EAD.
Context-Sensitive Menus for Series 3770 CPCs, EPC™ Monitor Model 3783, and WCPC Models 3787/3788

You can access context-sensitive menus, also called “popup menus,” by clicking the right mouse button when the cursor is in an active window. Each window has a popup menu.

The popup menus for the graph and for the table for the Series 3770 CPCs, EPC™ monitor Model 3783, and WCPC Models 3787 and 3788 are described in this section because they contain a few additional items that are not in any of the other menus.

Figure 4-26 below shows the popup menu for the graph window:

![Figure 4-26](image)

Figure 4-26  
Series 3770 CPC, Model 3783 EPC™ Monitor, and Models 3787/3788 WCPCs  
Context-Sensitive Menus for Graph Window

The popup menus for the series 3770 CPCs, EPC™ monitor Model 3783, and WCPC Models 3787 and 3788 have the following added selections:
1. **Display Count instead of Concentration.** Changes the display value to **Count per averaging interval** versus time instead of Concentration versus time if selected. The Y value is the total number of counter per averaging interval selected as shown in Figure 4-27. Default is Concentration. Both Count and Concentration are live-time coincidence corrected. See instrument manual for more information on live-time correction.

![Figure 4-27](image)

**Display Count per Averaging Interval versus Time**

2. **Display Analog Input 1 and/or Analog Input 2.** Series 3770 CPCs have the capability of sending external analog data along with the CPC data. Select this option to display the analog data along with the count or concentration data (see Figure 4-28). This option can be used to investigate the effect of other parameters such as temperature, humidity, and pressure, etc. on the particle concentration. The particle counter models (3783, 3787, and 3788) have only one analog input.

3. **Display Analog in Separate Graph.** This creates a two chart graph with one or two Analog data sets in the second chart. Both upper and lower charts share a common x axis data set, but each chart has its own Y axis data set as shown in Figure 4-29. Default is Single Chart display (see Figure 4-28).

4. **Analog Input Labels.** The analog input data is always in volts but the labels can be changed to describe the voltage source. For example, “Fan Pressure” could be entered instead of the default label “Analog 1”. The same name will appear in the Data Table also (see dialog in Figure 4-30).
Figure 4-28
Analog Signal and Concentration in a Single Chart

Figure 4-29
Two Chart Display with Analog 1

Figure 4-30
Enter Labels for Analog Channels
Figure 4-31 below shows the popup menu for the Series 3770 CPC table window when you right-click on the table window.

![Figure 4-31](image)

**Figure 4-31**
Series 3770 CPC Context-Sensitive Menus for Table Window

The Series 3770 CPCs, EPC™ monitor Model 3783, and WCPC Models 3787 and 3788 have the following added menu options:

<table>
<thead>
<tr>
<th>Count</th>
<th>Adds a column to display count values in addition to concentration values which are always displayed.</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Display Analog Input 1 and/or Analog Input 2</strong></td>
<td>These CPCs, EPC™ monitor, and WCPCs have the capability of sending external analog data along with the CPC count or concentration data. Select this option to display this data. The EPC™ monitor and WCPC models have only one analog input.</td>
</tr>
<tr>
<td><strong>Analog Input Labels</strong></td>
<td>The analog input data is always in volts but the labels can be changed to describe the voltage source. For example, “Fan Pressure” could be entered instead of the default “Analog 1”. The same name will also appear as labels on the graph (see Figure 4-30).</td>
</tr>
</tbody>
</table>
**Status Bar Icons**

A status bar at the bottom of most windows provides information about what is being shown in the window as well as information about what operations are occurring.

Each icon is described below:

<table>
<thead>
<tr>
<th>Icon</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>🚨</td>
<td>Attention. An error occurred while sampling and/or the sample ended early. Float the cursor over this icon to display a tool tip explaining the errors encountered.</td>
</tr>
<tr>
<td>🟢</td>
<td>Sampling completed without problems.</td>
</tr>
</tbody>
</table>
CHAPTER 5
Setting Up for Auto Recovery

This chapter describes how to setup and restart data collection after a power failure and how the Aerosol Instrument Manager® software resumes data collection tasks interrupted by the failure.

Note: The auto-power recovery feature applies only to a single CPC running Windows® XP. Auto recovery for multiple CPCs, EPC™ monitors, and WCPCs and for Windows Vista® or Windows® 7 operating system is not supported by the software.

The Aerosol Instrument Manager® software is designed to automatically restart data collection after the CPC/EPC™ monitor/WCPC and the computer or both have experienced a power failure.

To enable this feature, the monitoring computer must first be set to automatically restart and the Windows® XP operating system configured to automatically log on at system startup, as described in the following section.

Setting up the Computer and Operating System for Auto Recovery

To set up the computer for auto recovery, you need to:

- Configure the computer BIOS to boot up from the hard drive.
- Configure the computer to restart automatically.
- Download and install free software and configure and use it to modify Windows settings to perform an automatic Windows® XP operating system log on.

Follow these steps to configure and set up the computer and the operating system:

1. Shut down and restart the computer. As it boots up, messages such as “Press F2 to enter System BIOS” or “Press Del to Enter System BIOS” appear.
2. Press the appropriate key to access the computer BIOS settings.
3. If password has been previously set:

Enter the correct system or supervisor password in the Password settings box

*otherwise*

Select and enter a new password.

4. Check settings in the **Boot** section. Make sure the computer hard drive is listed as the first boot-up device.

5. Click **Save** and then exit from the BIOS settings.

After the boot up process is complete and the Windows desktop is displayed, perform Step 6.

6. Click **Start**, Right-click **My Computer**, and then click **Properties**.

7. Click the **Advanced** tab.

8. Under Startup and Recovery, click **Settings** to open the Startup and Recovery dialog box (Figure 5-1).

9. Select the **Automatically restart** check box, and click **OK** twice.

10. Download and install **TweekUI for Windows**, a free “PowerToy” software from the Microsoft website.

11. Select and run **TweekUI for Windows**.
12. In the TweekUI for Windows, select the Logon tab and check the Log on automatically at system startup box (Figure 5-2).

13. In the Username and Password boxes, enter the appropriate username and password and click Apply.
14. Select **Start** | **Control Panel** | **User Accounts**. The **User Account** dialog appears (Figure 5-3).
15. Uncheck the Users must enter a user name and password to use this computer box.

Data Collection Process After Power Failure

The following outlines the order in which the Aerosol Instrument Manager® software restarts and resumes the data collection process after the computer recovers and restarts following a power failure:

- Aerosol Instrument Manager® software starts automatically when Windows® XP operating system restarts.
- Aerosol Instrument Manager® software attempts to load the data file that was open when the shutdown occurred and displays the views that were open at that time.
- Aerosol Instrument Manager® software restores all the data collection scheduling parameters.
- Aerosol Instrument Manager® software reads the current time and then determines what tasks were scheduled for the time when the power failure occurred and the system shut down.
Depending on when the shutdown occurred, the following lists how Aerosol Instrument Manager® software resumes the data collection process:

- **All scheduled data collection was completed before the shutdown:**
  Auto-recovery settings are cleaned up and the Aerosol Instrument Manager® desktop is displayed waiting for the next scheduled data collection.

- **Data collection was scheduled to start before the shutdown:**
  When the next scheduled data collection time occurs, data collection starts without any interruptions as it would have before the shutdown.

- **Data was being collected and was in the process of collecting a data sample when the shutdown occurred:**
  A “stub” sample data file is started to collect the data over the remaining time of the scheduled sample. The first sample in this data file is stamped with **Power Failure Recovery Sample** in the comment field.
The Aerosol Instrument Manager® software stores data in two types of files: data files and project files. This appendix describes those files and the parameters stored in them. In addition, it also describes the parameters stored in the aim.ini file.

**Data Files and Project Files**

The Aerosol Instrument Manager® software uses two types of files:
- Data files
- Project files

**Data files** contain sample data. They have a filename extension to indicate the type of instrument from which data was collected, such as `.C07` for a Model 3007 CPC. The information stored in data files includes:

Information stored for the whole file:
- Number of samples in file
- Instrument Type

Information stored for each sample:
- Instrument ID
- Sample length
- Averaging interval
- Comment
- Sample title
- Time sample started
- Status flags from the instrument
**Project files** are created by the program when you open a data file and work with it. They have an extension to indicate the type of instrument that they are the project files for (for example, AIM1.p07 is the project file for data file AIM1.c07, for a Model 3007 CPC). Project files keep track of “cosmetic” attributes like which windows are open on the desktop when you close the file and how that information is displayed.

If you transfer data files to someone, you do not need to transfer the project files unless you want to. If you delete a project file, a new project file is created.

---

**Project File Parameters**

The following parameters are saved for each window:

- The graph type (bar, line, or area)
- The grid type shown on the graph (none, vertical, horizontal or both vertical and horizontal)
- Y axis scale parameters
- Position and size of the window

The following parameters apply to the entire file (not to each individual window):

- Playback delay time
- Current sample index (the sample number of the sample you were viewing when you exited the program)

---

**Saved Parameters**

The following parameters are stored for the Aerosol Instrument Manager® software application in the file aim.ini (located in the same directory where the Aerosol Instrument Manager® software application is installed) and are applied to all files:

- Font and color for tables.
- Font and color for graphs.
- Aerosol Instrument Manager® software window size and position.
- Samples view format (list, detail, or icons).
The following parameters are stored for each instrument type and are applied to all documents:

- Parameters (such as scheduling options) from the instrument Properties dialog box.
- Connection information such as communication port.
(This page intentionally left blank)
APPENDIX B

Accelerator Keys

Accelerator keys are those keys and key combinations that allow you to perform operations using only your keyboard (no mouse required).

These are the accelerator keys that can be used with your instrument.

<table>
<thead>
<tr>
<th>Key(s)</th>
<th>Action for a CPC, EPC™ monitor, WCPC, or EAD</th>
</tr>
</thead>
<tbody>
<tr>
<td>F1</td>
<td>Open user manual</td>
</tr>
<tr>
<td>F3</td>
<td>View statistics</td>
</tr>
<tr>
<td>F4</td>
<td>View settings</td>
</tr>
<tr>
<td>Alt B</td>
<td>Go to first sample “Begin”</td>
</tr>
<tr>
<td>Ctrl A</td>
<td>Select all in the Samples List window when the window is active</td>
</tr>
<tr>
<td>Ctrl C</td>
<td>Copy current view to clipboard</td>
</tr>
<tr>
<td>Alt E</td>
<td>Go to last sample “End”</td>
</tr>
<tr>
<td>Ctrl I</td>
<td>View instrument status</td>
</tr>
<tr>
<td>Ctrl K</td>
<td>2-pane window layout</td>
</tr>
<tr>
<td>Ctrl L</td>
<td>4-pane window layout</td>
</tr>
<tr>
<td>Alt N</td>
<td>Next sample</td>
</tr>
<tr>
<td>Ctrl N</td>
<td>New document file</td>
</tr>
<tr>
<td>Ctrl O</td>
<td>Open a document file</td>
</tr>
<tr>
<td>Alt P</td>
<td>Previous sample</td>
</tr>
<tr>
<td>Ctrl P</td>
<td>Print current view</td>
</tr>
<tr>
<td>Ctrl R</td>
<td>Display sample properties</td>
</tr>
<tr>
<td>Ctrl W</td>
<td>Close the current file</td>
</tr>
<tr>
<td>Z</td>
<td>Undo Zoom</td>
</tr>
</tbody>
</table>
APPENDIX C

Sequence Files

The files for sample sessions that run past midnight (or run for more than 24 hours) are handled differently than those that start and stop on the same date. (Midnight occurs on your system according to the setting of your computer’s system clock.)

For these sample sessions, a sequence of files is created, with each file in the sequence given a unique filename extension identifying its proper order.

Normally, only a single file is created for any sample session and it has a filename extension of the form .cxx. For example, Atmosphere.c07 would be identified as a 3007 CPC file.

If the sample session period runs past midnight, a file is created for each date (day). The samples collected before midnight (including the sample that is running at midnight) are collected in a file with the normal extension, i.e., .c07.

Samples that are collected after midnight are saved in a file with an extension of the form ".1.c07". (Using the same example as above, the next filename would be “Atmosphere.1.c07.”)

For a very long sample session, a file is created each time the sample session runs past midnight and is indicated by adding a new number to the file extension. Using the previous example, the file following “Atmosphere.1.c07” is “Atmosphere.2.c07” and the next file would be “Atmosphere.3.c07” and so on.

These files contain information to link them when opened and the files can be recalled as if they were a single file. The files may also be selected and opened as individual files.

When you save the samples collected during a sample session that runs past midnight, you provide a filename just as you would for any sample session. You do not provide any extensions. The software automatically adds a file extension.
Opening a File That is Part of a Sequence

If you select File|Open and the file is part of a sequence of files (i.e., the sample session ran over midnight), the following dialog box appears:

![File Question? Dialog Box](image)

You have the option of opening all the files or only a single one.

If you select No, only the file you have selected will open and only the samples in that file will be available to you.

If you select Yes, all files in the sequence will open and the samples from the entire session are available as if you had opened a single file.

Note: If you select View|Samples List|Details, you can see the pathname for each sample.

When you open a sequence of files, the software looks for the first file of that sequence (i.e., the one with the .c07 extension for a 3007 CPC and opens all files in sequence beginning with that file). If a sequence file is unavailable (for example, it has been deleted, moved or corrupted), the software opens the files until it comes to the missing file. For example, if you try to open a sequence of files that contains seven files and the fourth file is missing, only the first three files can be opened. Files five, six, and seven are “orphaned.” These remaining files (5, 6, and 7) can only be opened individually, not as a sequence.
APPENDIX D

Error Messages

This appendix lists the messages you may encounter when using the software and suggests the action you should take.

Table D-1
Error Messages for CPCs, EPC™ Monitor, WCPCs, and EAD

<table>
<thead>
<tr>
<th>Error Message</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>&lt;file&gt; already exists. Do you want to append to it?</td>
<td>The text file selected already exists. New exported data will be appended to the end of the file.</td>
</tr>
<tr>
<td>0 is invalid when using a log y scale.</td>
<td>You must enter a number greater than zero to proceed.</td>
</tr>
<tr>
<td>0 is not valid for the maximum value.</td>
<td>You must enter a number greater than zero to proceed.</td>
</tr>
<tr>
<td>The connected instrument is not a CPC 3775.</td>
<td>Verify the type of instrument you are connected to and the file type you opened. If you opened a file of type &quot;.c75&quot; then it is expected that you will connect to a CPC 3775.</td>
</tr>
<tr>
<td>Cannot communicate with the instrument. Please check that it is connected, turned on, has the correct comm settings set in the properties, and that the port is not in use by another application.</td>
<td>Communications error, the software cannot communicate with the instrument. Please check the items indicated in the message.</td>
</tr>
<tr>
<td>Cannot find a file (&lt;filename&gt;) in the sequence of files associated with &lt;filename&gt;. Only the samples loaded will be available.</td>
<td>Warning to let you know that the sequence of files has a gap and the program cannot load all of the files.</td>
</tr>
<tr>
<td>The connected CPC is not the Model selected.</td>
<td>Verify instrument configuration.</td>
</tr>
<tr>
<td>There is no data remaining.</td>
<td>There is no more data left in the file after samples marked for deletion have been removed.</td>
</tr>
<tr>
<td>Fixed Scale is selected. You must select a Minimum and/or Maximum value.</td>
<td>If you want to use the fixed scale parameter, you must select a minimum or maximum value.</td>
</tr>
<tr>
<td>Log y scale is invalid because the minimum y scale value is set to 0.</td>
<td>You have tried to select log Y scale and you also have 0 as the fixed minimum value. You cannot have both selected. Change one.</td>
</tr>
<tr>
<td>Maximum value must be &gt; minimum value.</td>
<td>You have entered a minimum value that is greater than the maximum value. Reenter the correct values.</td>
</tr>
<tr>
<td>File Missing.</td>
<td>One of the files in a sequence cannot be found.</td>
</tr>
<tr>
<td>Sample #x will be discarded and cannot be recovered. Do you want to discard it?</td>
<td>Answer yes if you want to permanently remove the sample from the file.</td>
</tr>
<tr>
<td>Unable to verify One Second Averaging Mode (SAV0).</td>
<td>EAD only. Before sampling begins, Aerosol Instrument Manager tries to verify that the EAD is configured for 1-second averaging mode. This mode affects how the EAD calculates and updates the diameter concentration readings read by Aerosol Instrument Manager. You have the option to not start sampling. You may try to start sampling again. If this message reappears, consult the EAD Instrument Manual.</td>
</tr>
<tr>
<td>Error Message</td>
<td>Description</td>
</tr>
<tr>
<td>------------------------------------------------------------------------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>The instrument is reporting:</td>
<td>Select <strong>Yes</strong> to start sampling or select <strong>No</strong> if you do not want to start sampling at this time.</td>
</tr>
<tr>
<td>CPC Fault; Temp Low</td>
<td></td>
</tr>
<tr>
<td>Do you want to start sampling anyway?</td>
<td></td>
</tr>
<tr>
<td>Unable to read instrument status due to communication error.</td>
<td>Before sampling begins, Aerosol Instrument Manager verifies the status of the instrument. It was unable to read the instrument status.</td>
</tr>
<tr>
<td>The boundaries range is invalid.</td>
<td>The start time selected for the view boundary cannot exceed the end time.</td>
</tr>
<tr>
<td>You must stop data collection before exiting Aerosol Instrument Manager.</td>
<td>Attempt to exit Aerosol Instrument Manager during a sample run.</td>
</tr>
<tr>
<td>There is no data to be saved.</td>
<td>Attempt to save a file with no sample data.</td>
</tr>
<tr>
<td>The file you have selected is part of a sequence of files. Do you want to view all the files?</td>
<td>You have selected a file that is part of a sequence of files. You can select Yes to view all the files or No to view only the file you initially selected.</td>
</tr>
<tr>
<td>The User Defined inter sample time is less than the sample length.</td>
<td>Properties! Scheduling values are invalid.</td>
</tr>
<tr>
<td>The starting hour is invalid</td>
<td>Properties! Scheduling values are invalid.</td>
</tr>
<tr>
<td>The Hours field cannot be blank.</td>
<td>You must enter a value in this field.</td>
</tr>
<tr>
<td>The Minutes field cannot be blank.</td>
<td>You must enter a value in this field.</td>
</tr>
<tr>
<td>The number of samples cannot be zero.</td>
<td>You must enter a value greater than 0 in this field.</td>
</tr>
<tr>
<td>The sample length cannot be zero.</td>
<td>You must enter a value greater than 0 in this field.</td>
</tr>
<tr>
<td>The Averaging Interval cannot be zero.</td>
<td>You must enter a value greater than 0 in this field.</td>
</tr>
<tr>
<td>The Sample Length should be equal to or greater than the Averaging Interval.</td>
<td>You must enter a sample length equal to or greater than the averaging interval.</td>
</tr>
<tr>
<td>The maximum data points allowed are 10,000. You need to change the value of either the sample length or the averaging interval.</td>
<td>The sample length divided by the averaging interval cannot exceed 10,000.</td>
</tr>
<tr>
<td>The Sample Length should be divisible by the Averaging Interval.</td>
<td>Properties! Scheduling values are invalid.</td>
</tr>
<tr>
<td>The properties for sample #x could not be saved.</td>
<td>Unable to save changed property values for the sample.</td>
</tr>
<tr>
<td>Unable to create the graph control.</td>
<td>Contact TSI for support.</td>
</tr>
<tr>
<td>Unable to start Timer for CPC data collection.</td>
<td>Try to restart Aerosol Instrument Manager. If this message reappears, reinstall Aerosol Instrument Manager. Contact TSI for support.</td>
</tr>
<tr>
<td>There are no samples selected.</td>
<td>CPC 3007 only. You must select the samples you want to receive from the 3007 before pressing the Receive button.</td>
</tr>
<tr>
<td>Unable to read information for Sample #x.</td>
<td>CPC 3007 only. Re-select the sample to download and press the Receive button again.</td>
</tr>
<tr>
<td>Invalid Log Interval 2</td>
<td>CPC 3007 only. Check the format of the string you entered. It must be of the form mm:ss, where mm = minutes, ss = seconds.</td>
</tr>
<tr>
<td>Unable to program Log Mode 1 Log Intervals 5.</td>
<td>CPC 3007 only. Retry this command. If problem persists, contact TSI for support.</td>
</tr>
<tr>
<td>Invalid Instrument Time.</td>
<td>CPC 3007 only. Check the format of the time string entered.</td>
</tr>
<tr>
<td>Error Message</td>
<td>Description</td>
</tr>
<tr>
<td>---------------------------------------------</td>
<td>----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Invalid Instrument Date</td>
<td>CPC 3007 only. Check the format of the date string entered.</td>
</tr>
<tr>
<td>Unable to program the instrument time</td>
<td>CPC 3007 only. Retry this command. If problem persists, contact TSI for support.</td>
</tr>
<tr>
<td>Unable to program the instrument date</td>
<td>CPC 3007 only. Retry this command. If problem persists, contact TSI for support.</td>
</tr>
<tr>
<td>Error receiving Sample x3 data.</td>
<td>CPC 3007 only. Retry. If download continues to fail, the data stored on the 3007 may be corrupt or invalid.</td>
</tr>
<tr>
<td>The amount of data received was not what was expected.</td>
<td>CPC 3007 only. Retry. If download continues to fail, the data stored on the 3007 may be corrupt or invalid.</td>
</tr>
</tbody>
</table>
(This page intentionally left blank)
Index

A
abort current sample, 4-29
about Aerosol Instrument Manager, 4-39
about this manual, xi
accelerator keys, B-1
active window, 1-3
add sample properties, 4-16
analog and concentration in a single chart, 4-42
analog input
   models 3783, 3787, 3788, 4-41
analog input label, 4-41
analog input labels, 4-43
arrange windows, 3-10
attention icon, 4-44
auto export, 4-29
auto recovery, 5-1
AutoPlay, 2-2
available memory, 4-20
available memory %, 4-7
available ports, 4-11
averaging interval, 4-3

B
beginning sample, 4-38

C
change how data is viewed, 3-3
check time, 4-4, 4-22
clear instrument memory
   model 3007, 4-29
clear memory, 4-23
clear memory error message
   model 3781, 4-23
collecting sample data, 4-11
color, 4-33
color and font toolbar, 4-37
column orientation, 3-10
communications error dialog box, 4-12, 4-13
communications lost, 4-9
communications tab, 4-10
communications tab, 4-9
communications tab
   properties dialog box, 4-10
communications tab
   for Series 3770 CPCs, EPC™ monitor 3783, and
   WCPC 3787 and 3788, 4-10
communications tab
descriptions, 4-11
comparison table, 1-2
condensation particle counter
   manuals, xii
   model 3007, xii
   model 3771, xii
   model 3772, xii
   model 3775, xii
   model 3776, xii
   model 3781, xii
   model 3783, xii
   model 3785, xii
   model 3787, xii
   model 3788, xii
   connect to instrument, 4-29
context-sensitive menu
   graph window
      models 3783, 3787, 3788, 4-40
      series 3770, 4-40
      models 3783, 3787, 3788, 4-40
      series 3770, 4-40
   table window
      series 3770, 4-43
convert and import Series 3770 files, 4-17
copy, 4-37
count, 4-43

data collection
   automatic restart, 5-1
   data collection after power failure, 5-5
   data collection interruption, 5-1
   data conversion
      series 3770, 4-15
data files, A-1
      model 3007, A-1
data hotspot, select, 3-6
data import and logging
      model 3781, 4-19, 4-26
data logging dialog box
      model 3781, 4-23
data logging dialog box
      model 3781, 4-22
data merge icon, 4-37
data merge software, 2-1
data recovery, 5-1
default, 4-6, 4-8
delete/undelete sample, 3-6, 4-38
description of scheduling parameters, 4-2, 4-4
descriptions for communications tab, 4-11
descriptions for CPC Log Modes 2 and 3 Tab, 4-7
descriptions for the CPC 3007 Log Mode 1 Tab, 4-6
descriptions of CPC 3007 Instrument Clock Tab, 4-9
desktop, 3-1
diameter concentration, 1-1
disconnect from instrument, 4-29
display analog in separate graph, 4-41
display analog input 1 and/or analog input 2, 4-41, 4-43
display count instead of concentration, 4-41
display count per averaging interval versus time, 4-41
downloading remotely sampled data
  model 3007, 4-12

E
elapsed time, 3-10
electrical aerosol detector
  model 3070A, xii
ending sample, 4-38
time channels, 4-42
error message, D-1, D-2, D-3
  model 3007, D-2, D-3
time channels, 4-38
example files, 3-2
exit, 4-23
export data, 3-9
  automatically, 3-10
  manually, 3-9
export data options box, 3-9
extensions, 4-13
  CPC, 4-12

F
fan pressure, 4-43
file menu, 4-24
  3781 WCPC data import and logging, 4-26
  close, 4-25
  exit, 4-28
  export, 4-27
import data files
  3770 series, 4-26
    models 3783, 3787, 3788, 4-26
list of recently accessed files, 4-27
new, 4-24
open, 4-25
print, 4-27
print preview, 4-27
print setup, 4-27
properties, 4-27
save, 4-25
save as, 4-26
file menu options, 4-24
file parameters, A-1
file question? dialog box, C-2
finish current sample, 4-28
flash memory card, 4-15
  3770 series, 4-14
font, 4-35
font dialog box, 4-35
format menu, 4-31
  color, 4-33
  font, 4-35
  graph type, 4-32
  grid lines, 4-33
  screen, 4-31
  undo zoom, 4-35
  view boundaries, 4-32
  Y-axis, 4-31

G
general purpose water-based condensation particle counter
  model 3787, xii
getting help, xiii
getting started, 3-1
graph, 4-36
  graph color dialog box, 4-34
  graph toolbar, 4-37
  graph type, 4-32
  grid lines, 4-33

H
help, xiii
help manual, 4-39
help menu, 4-39
  screen, 4-39

I–J
icons
  playback, 3-4, 3-5
  status bar, 4-44
import data files
  3770 series, 4-26
    models 3783, 3787, 3788, 4-26
import data from USB memory stick
  models 3783, 3787, 3788, 4-18
import/logging dialog box
  model 3781, 4-19
importing data
  models 3783, 3787, 3788, 4-18
input Aerosol Instrument Manager file name, 4-17
installation, 2-2
  procedure, xi, 2-1
  requirements, xi, 2-1
instrument, 4-11
instrument clock tab, 4-9
  model 3007, 4-8
instrument data files dialog box, 4-15
instrument date, 4-9
instrument properties, 4-1
instrument status, 4-36
  model 3007, 4-36
instrument time, 4-9
introduction, 1-1

K
keys. (see accelerator keys)

L
list of recently accessed files, 4-27
log interval, 4-7
log mode 1 tab, 4-6
  model 3007, 4-5
log modes 2 and 3
  model 3007, 4-6
log start and log stop, 4-20
lost communications, 4-9

M
main toolbar, 4-37
manual
  model 3007, xii
  model 3070A, xii
  model 3771, xii
  model 3772, xii
  model 3775, xii
  model 3776, xii
  model 3781, xii
  model 3783, xii
  model 3785, xii
  model 3786, xii
  model 3787, xii
  model 3788, xii
  notations/conventions, 1-3
mark samples for deletion, 3-6
menu options
  models 3783, 3787, 3788, 4-43
  series 3770, 4-43
menus, 4-23
message line, 4-18, 4-21

N
nano water-based condensation particle counter
  model 3788, xii
navigation, 1-1
navigation toolbar, 4-37
next sample, 4-38
notations/conventions, 1-3
number of samples, 4-2, 4-7

O
OK icon, 4-44
open an existing file, 3-2
open instrument associated data files window, 3-2
organization of manual, xi

P
particle concentration, 1-1
  model 3007, 1-2
    models 3010, 3010D, 3760A, 3762, 1-2
    models 3771, 3772, 3775, 3776, 1-1
models 3781, 3785, 3786, 3022A, 3025A, 1-1
models 3783, 3787, 3788, 1-1
pause, 4-30
percent memory required, 4-8
play, 4-30
playback data samples, 3-4
playback icons, 3-4, 3-5
playback menu, 4-30
  pause, 4-30
  play, 4-30
  screen, 4-30
  stop, 4-31
playback menu items, 3-5
playback setup dialog box, 3-5
port, 4-11
power failure, 5-1
preview, print, 3-8
previous sample, 4-38
print information displayed, 3-8
print preview, 4-27
  screen, 3-8
print setup, 4-27
project file, A-2
  parameters, A-2
project files, A-1
properties, 4-30
properties dialog box, 4-1
purpose of manual, xi

Q
quit the program, 3-11

R
read memory, 4-19
README.TXT file, 2-2
receive logged data
  model 3007, 4-29
receive samples from instrument dialog box, 4-13
refresh, 4-6, 4-8, 4-9
row orientation, 3-10
RS-232 serial interface port, 2-2
run menu, 4-28
  abort current sample, 4-29
  auto export, 4-29
  clear instrument memory, 4-29
  connect to instrument, 4-29
  disconnect from instrument, 4-29
  finish current sample, 4-28
  instrument status, 4-36
  properties, 4-30
  receive logged data, 4-29
  screen
    model 3007, 4-28
  start data collection, 4-28
  stop current sample, 4-29

S
sample data
  collecting, 4-11
  sample length, 4-2, 4-7
sample menu, 4-37
beginning sample, 4-38
delete/undelete sample, 4-38
ending sample, 4-38
next sample, 4-38
previous sample, 4-38
screen, 4-38
select all, 4-38
sample properties, 4-20
sampled data
  downloading, 4-12
samples, 4-20
samples list window, 3-3, 3-5
save as, 4-20
saved parameters, A-2
scheduled, 4-3
scheduling parameters, 4-2
3783, 3787, 3788, 4-4
description, 4-2, 4-4
scheduling tab, 4-2
3783, 3787, 3788, 4-4
properties dialog box, 4-2, 4-4
select all, 4-38
selecting files to import, 4-15
send, 4-6, 4-8, 4-9
sequence files, C-1
serial no., 4-11
serial number, 4-7
setting up instrument properties, 4-1
settings, 4-36
settings tab, 4-5
  properties dialog box, 4-5
software, 2-1
  getting started, 3-1
  installation, 2-1, 2-2
  license, vi
  procedures, 4-1
  starting program, 3-1
start, 4-22
start at time, 4-3
start data collection, 4-28
start date, 4-7
start the program, 3-1
start time, 4-7
startup and recovery, 5-3, 5-5
statistics, 4-36
status, 4-11
status bar icons, 4-44
stop, 4-22, 4-31
stop current sample, 4-29
sync, 4-5
sync instrument clock at midnight, 4-4
synchronize, 4-22
system date, 4-9
system time, 4-9

T
  table, 4-36
table color dialog box, 4-34
test button, 4-11
test results, 4-11
text file, 4-21
time between samples, 4-8
time stamp, 3-10
toolbar icons, 3-5
toolbars, 4-37
total sample time, 4-3
Tweak UI, 5-4
two chart display with analog 1, 4-42
two-panel layout of CPC file, 3-11

U
ultrafine water-based condensation particle counter
  model 3786, xii
undelete/delete samples, 3-6
undo zoom, 4-35
unzoom, 3-7
USB memory stick, 4-18
USB port, 2-2, 4-9

V
  version, 4-11
  view boundaries, 4-32
  view menu, 4-35
copy, 4-37

view menu (continued)
  graph, 4-36
  screen, 4-36
  settings, 4-36
  statistics, 4-36
table, 4-36
toolbars, 4-37
view multiple samples, 3-4

W–X
window menu, 3-10, 4-39
  screen, 4-39

Y
  y-axis dialog box, 4-32

Z
  zoom in/zoom out, 3-7
Reader’s Comments

Please help us improve our manuals by completing and returning this questionnaire to the address listed in the “About This Manual” chapter. Feel free to attach a separate sheet of comments.

Manual Title Aerosol Instrument Manager® Software for CPC, EPC™ Monitor, WCPC, and EAD  
P/N 1930062  Rev. J

1. Was the manual easy to understand and use?  
☐ Yes  ☐ No

1. Please identify any problem area(s) ____________________________________________________

_________________________________________________________________________________________

_________________________________________________________________________________________

2. Was there any incorrect or missing information? (please explain) __________________________

_________________________________________________________________________________________

_________________________________________________________________________________________

3. Please rate the manual according to the following features:

<table>
<thead>
<tr>
<th>Feature</th>
<th>Good</th>
<th>Adequate</th>
<th>Poor</th>
</tr>
</thead>
<tbody>
<tr>
<td>Readability</td>
<td>☐</td>
<td>☐</td>
<td>☐</td>
</tr>
<tr>
<td>Accuracy</td>
<td>☐</td>
<td>☐</td>
<td>☐</td>
</tr>
<tr>
<td>Completeness (is everything there?)</td>
<td>☐</td>
<td>☐</td>
<td>☐</td>
</tr>
<tr>
<td>Organization (finding what you need)</td>
<td>☐</td>
<td>☐</td>
<td>☐</td>
</tr>
<tr>
<td>Quality and number of illustrations</td>
<td>☐</td>
<td>☐</td>
<td>☐</td>
</tr>
<tr>
<td>Quality and number of examples</td>
<td>☐</td>
<td>☐</td>
<td>☐</td>
</tr>
</tbody>
</table>

Comments: ______________________________________________________________________________

_________________________________________________________________________________________

_________________________________________________________________________________________

4. Which part(s) of this manual did you find most helpful? _________________________________

_________________________________________________________________________________________

_________________________________________________________________________________________

5. Rate your level of experience with the product:

☐ Beginning  ☐ Intermediate  ☐ Expert

6. Please provide us with the following information:

Name _______________________________  Address _______________________________

Title _______________________________  _______________________________________

Company ___________________________  _______________________________________
